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Safety
Considerations

Warnings,
Cautions, &
Notes

Thermo Fisher Scientific

Safety Information & Guidelines

This section contains information that must be read and understood by all
persons installing, using, or maintaining this equipment.

Failure to follow appropriate safety procedures or inappropriate use of the
equipment described in this manual can lead to equipment damage or
injury to personnel.

Any person working with or on the equipment described in this manual is
required to evaluate all functions and operations for potential safety hazards
before commencing work. Appropriate precautions must be taken as
necessary to prevent potential damage to equipment or injury to personnel.

The information in this manual is designed to aid personnel to correctly
and safely install, operate, and/or maintain the system described; however,
personnel are still responsible for considering all actions and procedures for
potential hazards or conditions that may not have been anticipated in the
written procedures. If a procedure cannot be performed safely, it must not
be performed until appropriate actions can be taken to ensure the safety
of the equipment and personnel. The procedures in this manual are not
designed to replace or supersede required or common sense safety practices.
All safety warnings listed in any documentation applicable to equipment
and parts used in or with the system described in this manual must be read
and understood prior to working on or with any part of the system.

Failure to correctly perform the instructions and procedures in this
manual or other documents pertaining to this system can result in
equipment malfunction, equipment damage, and/or injury to personnel.

The following admonitions are used throughout this manual to alert users
to potential hazards or important information. Failure to heed the
warnings and cautions in this manual can lead to injury or equipment
damage.

Warning Warnings notify users of procedures, practices, conditions, etc.
which may result in injury or death if not carefully observed or followed.
The triangular icon displayed with a warning may contain a lightning bolt
or the radiation symbol, depending on the type of hazard. A
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Safety Information & Guidelines
Warnings, Cautions, & Notes

Caution Cautions notify users of operating procedures, practices,
conditions, etc. which may result in equipment damage if not carefully
observed or followed. A

B =gl

Note Notes emphasize important or essential information or a statement of
company policy regarding an operating procedure, practice, condition,
etc. A
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Thermo Fisher Scientific

Fieldbus
Overview

Chapter 1
Product Overview

The Thermo Scientific DensityPRO is designed to provide reliable and
accurate measurements of process material density for a variety of
challenging applications. With FOUNDATION™ fieldbus, the gauge also
provides users with access to control or program parameters via a host
system.

Note This guide contains information specific to applications using the
DensityPRO with FOUNDATION fieldbus. For information on the standard
DensityPRO, reference the DensityPRO user guide (P/N 717784). a

Fieldbus is an all-digital communication system between devices on the
bus. The DensicyPRO with FOUNDATION fieldbus provides the following:

e Execution of control functions (algorithms) in the actual device

e Device registration with the Fieldbus Foundation™, ensuring
compatibility with the devices of other systems

e Ability to configure using device specific device description (DD)

e Ability to send data directly between devices

Note This manual assumes a working knowledge of FOUNDATION fieldbus
terminology and practices. For additional information on FOUNDATION
fieldbus, visit http://www.fieldbus.org. A
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Product Overview
Fieldbus Overview

Links and Devices

Blocks

A FOUNDATION fieldbus network consists of links and devices. A link is the
serial bus that connects the devices on the network. There are three types of
devices:

e Link master: The DensityPRO with FOUNDATION fieldbus has link
master capabilities. This device type controls communications traffic on
a link and prevents multiple devices from communicating data at the
same time. A link master may also be the Link Active Scheduler (LAS),
which is the device that is currently controlling access to the fieldbus. A
fieldbus network may have more than one link master per link, but
there may be only one LAS at a time.

e Basic device: This device type can communicate on the fieldbus
network, but it cannot become the LAS.

e Bridge: This device type connects two or more links in a fieldbus
network.

A device is identified by its device tag and device ID. The device tag is the
unique name you assign to it, and the device ID is a unique identifier
assigned by the manufacturer. The device ID cannot be changed.

Blocks allow you to configure and control the fieldbus gauge. A block is
identified by its block tag, which is similar to the device tag. The block tag
uniquely identifies the block on the network.

Linkages connect two blocks and enable the transfer of data from one

function block to another. The DensityPRO supports the following blocks:

e One resource block (RB): Contains device information, such as the
device tag and device ID.

e One transducer block (TB): Allows you to configure or view setup
parameters and access system diagnostic tools.

e Four analog input blocks (Al): Makes manufacturer's input data
available to other functions at its output.

The figure below illustrates how the blocks are interconnected by default.

1-2 DensityPRO with FOUNDATION™ fieldbus Application Guide Thermo Fisher Scientific



Sensor signal
evaluation

A

Transducer Block
(parameters that
describe the device)

Physical Block
(parameters of the
physical unit)

Product Overview

Fieldbus Overview

Primary value
(main value)

y

Analog Input Block
(parameters important to the
process control system)

Figure 1-1. Default block configuration

Inputs & Outputs

Thermo Fisher Scientific

The characteristics of the input and output options for the DensitcyPRO
with FOUNDATION fieldbus are summarized in the table below.

Note The I/O listed below can be configured via FOUNDATION fieldbus.
More I/O are available with the standard DensityPRO but can only be

configured using other interfaces. Reference the DensityPRO user guide
(P/N 717784). A

Table 1-1.
Type Characteristics Comments
Current output 3.8-20.5mA DC. Default range is 4-20 mA DC. One

Standard configuration:

- Isolated, loop-powered, 24
Vdc input, 700 ohm max. load.

Alternate configurations:
- Non-isolated, self-powered,
700 ohm max. load.

- Isolated, self-powered, 700
ohm max. load.

current output is provided on the
CPU.

Piggyback board (P/N 886595)
required for isolated, self-powered
configuration.

Optional relays

Two relays optionally available on
the AC power/ relay board.

Form C SPDT, isolated 8 A, 220
Vac.

Process alarms and system fault or
warning alarms can be assigned to
control (open/close) relays.

Contact closure
inputs

Two contact closure inputs
provided on the CPU.

Execute system commands based
on a user-provided contact switch
opening or closing input.

DensityPRO with FOUNDATION™ fieldbus Application Guide
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Product Overview
Using this Application Guide

Using this This document was created specifically for applications using the
. . DensityPRO with FOUNDATION fieldbus. Refer to the DensityPRO user
Appl ication guide (P/N 717784) for a complete set of instructions and details on the

G uide menu structure and functionality of the standard DensityPRO.

A working knowledge of FOUNDATION fieldbus is assumed.

Associated Along with this guide, the following documents must be read and
Documentation understood by all persons installing, using, or maintaining this equipment:

e DensityPRO user guide (P/N 717784)
e DensityPRO installation guide (P/N 717774)
e Gamma Radiation Safety Guide (P/N 717904)

e National Instruments™ NI-FBUS Configurator user manual (if using
the NI-FBUS Configurator as the host system) or documentation
supplied with your host

1-4  DensityPRO with FOUNDATION™ fieldbus Application Guide Thermo Fisher Scientific



Chapter 2
Wiring & Connections

Note This chapter provides wiring details for fieldbus operation. It is
assumed that the instrument has already been installed (refer to the
DensityPRO installation guide). A

The fieldbus connector is accessible from the faceplate of the DensityPRO.

2 [CONN. &
m N sadl
PR
GND \K\ GND
- SiM S— SIM
yi ~= GND
I] l HW
T =g,
D. N g0l [ g IG# P I00F
Cl ® [+ g rsﬁ“ ) dar
- D Jlow sa ® e
- - 3®
- i s 3 ha 8
Wk X -\
) ) :::-n.- EA'* 2% ‘:- ’3«5
- o3 s 7 .
== || U ‘1 < ™ @ o 3 $6‘ ¢ \
= S EPN 5

Figure 2-1. Signals on the DensityPRO FOUNDATION fieldbus connector

The only connections required for operation are to the H1 bus.

Table 2-1. H1 bus to DensityPRO fieldbus connector

H1 Bus DensityPRO Fieldbus Connector
Positive lead FFB-FP
Negative lead FFB-FN

Thermo Fisher Scientific DensityPRO with FoUNDATION™ fieldbus Application Guide ~ 2-1



Wiring & Connections
Associated Documentation

Note Refer to FOUNDATION fieldbus specification for cable sizes and
maximum cable length. A

Cable length = trunk length + all spur lengths

Maximum length = 1900 meters with “type A” cable
Table 2-2. Spur lengths

Device Spur Length (meters)
25-32 1

19-24 30

15-18 60

13-14 9

1-12 120

The following table lists the possible jumper settings for the fieldbus board.

Table 2-3. Jumper settings for fieldbus board

Jumper Default Setting Description
SIM Off For testing only. Puts interface in a simulation mode.
HW Off Hardware write lock. Not supported. (Software write

lock supported. Access WRITE_LOCK parameter
through RESOURCE > Process or Options tab.)

2-2  DensityPRO with FounDATION™ fieldbus Application Guide
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Install the
Device
Description

Thermo Fisher Scientific

Chapter 3
The NI-FBUS Configurator

This chapter describes how to use the NI-FBUS Configurator with the
DensityPRO. It is assumed that you have installed the instrument and the
application software and that all necessary connections have been made.

Note This manual assumes a working knowledge of FOUNDATION fieldbus
terminology and practices. A

Note This chapter was written based on using the National Instruments
NI-FBUS Configurator. If you are using this application software,
additional information can be found in the configurator user manual (open
the configurator and go to Help > User Manual). If you are not using the
NI-FBUS Configurator, reference the documentation that came with your
host system. A

To install the device description (DD), go to www.fieldbus.org. Search the
list of registered devices to locate the Thermo Scientific DensityPRO
DD/CEFF files. Download the files and unzip them.

DensityPRO with FOouNDATION™ fieldbus Application Guide  3-1



The NI-FBUS Configurator
Configurator Startup

Configurator
Startup

Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

ﬁ 1. Launch the NI-FBUS Configurator by selecting Start > Programs >
el Nationallnstruments > NI-FBUS > NI-FBUS Configurator, or
@%? double-click the NI-FBUS icon on the PC desktop.
NI-FBUS icon

2. A dialog appears informing you that NIFB.EXE has not been launched.
Click Yes to start the program.

3. When the NI-FBUS Configurator dialog appears, verify Any Project is
selected and click OK to start program.

~2:M1-FBUS Contigurator(Ver 3.2.1)

[ o s g | 7, meven

Help Wirdows - wsed lor deplang deace
Kescrphions and geressl configashon help
friomation.

NI-FBUS Configurator(Ver 3.2.1)

Creste Mew Project
E % finy Projecticontsing both onine and offine nks)
 Difine Project fonky conlains olfine finks)
Added link(s)
Winterdace0-0

[, Open an Exisling Project fep)
L

DL1S/10 10:21:18

Figure 3-1. The NI-FBUS Configurator dialog box
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The NI-FBUS Configurator
Configurator Startup

4. Reference Figure 3-2 for this step.

a. The NI-FBUS Configurator automatically detects all valid devices
connected to the network. If the connected devices are registered by
the Fieldbus Foundation as compliant devices and the DD files
have been imported, the configurator will detect the device and the
blocks contained within the device. This process can take a few
minutes. When complete, the configurator main screen will open,
and the configuration tree will display all valid devices found on the
network.

b. Check the blocks available.
RESOURCE_ XXXXXXXXX (RB2): The resource block

contains device information, such as device name and serial
number.

AI_TRANSDUCER_ XXXXXXXXX (AITB): Open the
AI_TRANSDUCER block to configure or view setup

parameters and access system diagnostic tools.

ANALOG_INPUT_ XXXXXXXXX (AlI): There are four
ANALOG_INPUT blocks (AI), which take the manufacturer's
input data and makes it available to another function at its
output.

#= NI-FBUS Configurator(Ver 3.2.3) : FCP1
Fie Configurs  View ‘Window Help
| Clvece FaRP Grid || 2, Hide Help

O &8 24 2LE mR By

= =8 pkerfacel-0
8 Netweork Paramaters
5 Schedue
065100079
085100073 (RB2)
085100073 (ATTE)
085100079 (AT}
085100079 (A1)
@ ANALOG_INPUTS 085100079 (A1)
@ ANALOG_INPUT4 085100079 (AT}

|
Walid device detected on network

read data object.. . success ¢|
PARAMETER "LO_LO_ALM":
read data object. . success (08:03:11)

LINK "interfacel-0" is currently idle, (08:03:12)
-
[\Stobus ADovwrload ) Enon i AssgnmentiLive et/ 4| | ;Ij
[Ready O7/0610 08:33:43

Figure 3—-2. NI-FBUS main screen
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The NI-FBUS Configurator
Configurator Interface

5.

Configurator
Interface

Double-click on DensityPRO_XXXXXXXXX to view the device
properties. If the DensityPRO has been connected correctly, PD tag,
the device ID, and node address are shown. The PD tag is the physical
name of the device. The device ID is a unique device identifier.
Following is an example of a typical device ID:

5446530200_XXXXXXXXX
In this case,
544653 is the manufacturer ID
0200 is the device type
XXXXXXXXXXXX is the serial number
The node address is the device address. The PD tag and node address

can be changed using the configurator software or host system.

Note Additional information on the NI-FBUS Configurator can be found

in the configurator user manual (Help > User Manual). If you are not
using this configurator, reference the documentation that came with your
host system. A

The main screen of the NI-FBUS Configurator is composed of the object
menu, the toolbar, and several windows. These are shown below.

Object menu Toolbar Middle frame Help window

(08:03 11)
03:12)

Status window Configuration Tree

Figure 3-3. Parts of the NI-FBUS Configurator main screen
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The Configuration
Tree & Object Menu

The Middle Frame

Thermo Fisher Scientific

The NI-FBUS Configurator
Configurator Interface

The configuration tree displays the objects on the network that are
configurable. Double-click on a device to the view the device properties.

Each object in the tree has its own main menu. For example, click on the
Network Parameters. The object menu consists of the following items:
File, Network Parameters, Configure, View, Window, and Help. Click on
Function Block Application, and the Network Parameters object menu
item changes to Function Block Application.

#= NI-FBUS Configurator(Ver 3.2.3) : FCP1

e v Pt e . oo 15

+% NI-FBUS Configurator(Ver 3.2.3) : FCP1

= Gbars Ve vnion 1o

[CIHide FBAP Grid || 7, Hide Help [CIHide FBAP Grid || 7, Hide Help
Ol 2@ (s am o2& ssnuwil
= &8 nterface0-0 = &a nterfaced-0
2 @ Network Parameters
] Schedule B Schedule
&3 Function Block Appiication 7Y Fusnction Block Appication
% interface0-0 ‘% interface0-0
- % DensityPRO__________ 085100079 = [ DensityPRO 085100079
@ RESOURCE  ____ 085100079 (RB2) @ RESOURCE 085100079 (RB2)
@ AI_TRANSDUCER _____ 085100079 (AIT} @ AI_TRANSDUCER 085100079 (AITI

Figure 3-4. Object menus for Network Parameters and Function Block
Application

The contents of the middle frame can vary, depending on what you are
currently doing. For instance, if you double-click on the Function Block
Application (FBAP) object in the configuration tree, the FBAP grid opens

in the middle frame.

You can open multiple windows in the middle frame. Use the Minimize,
Restore Down, and Close buttons in top right corner of the window as you
would in other Windows®-based programs.
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The NI-FBUS Configurator
Configurator Interface

#F NI-FBUS Configurator(Ver 3.2.3) - [interface0-0 : Function Block Application]

W3 Fle Edk Configure Zoom View Window Help
| Cltide FBAP Grid || 7, Hide Help

QO & 8L L R L@ 3| [owTme=Tsec —=[SteleLimt=1 H O rPO | WSARE S @ BLOCK "ANALOG_IMPUTT
= &2 interface0-0 — CABI0TI AI
B Network Parameters The Analog Input (41] block takes
Schedule the manudacturer's input data,
3 Function Block Applcation selected by channel number, and
% interfacen-0 ;‘w‘*\c:;: ;.‘;E):;: :J}“M
- [ DensityPRO 085100079 )
@ RESDURCE 085100079 (RBZ) Block help - Double click o« right
@ AI_TRANSDUCER 085100079 (AT chokcon e v ectbock
@ ANALOG_INPUT1 085100079 (AT geaued!otaqlhe e o,
@ ANALOG_INPUTZ 085100079 (AT, ahes parameters in the block
@ ANALOG_INPUT3 085100079 (AT,
@ ANALOG_INPUT4 085100079 (AT,

Ready

=)
¢ 3 (4] | [
read data object...success B
PARAMETER "LO_LO_ALM"
read data object.. success (08:03:11)
LINK “interface0-0" is currently idle (08:03:12) j
-
' Statues ADownload) Emorsh Assignment Live List/ i‘ ﬂ
O7/06/10 05:43:08

Figure 3-5. FBAP grid opens in the middle frame

The Help Window
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The help window displays the help information available for a particular
object or parameter. Move the cursor over any object in the configuration
tree, and the help for that object will be displayed. Help is also displayed

for block parameters when you click on them.
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The NI-FBUS Configurator
Configurator Interface

= NI-FBUS Configuratar(Ver 3.2.3)

i Domsitypro

DB5100079 : Al_TRAN,

@ PARAMETER "TAG_DESC”

[A_TRANSDUCER BHE EE 28N B e

¥ Pesiodic Updales |2 [zec] 5: er_wmuummm
005 [[auo TAG_DESC =
Frocess | 1/0 Conig | Alaims | Diagnostics | Trends | Othess | Method: | [
Paramster Value Type LE:
TAG_DESC Help - The uses desciption of the
5 @ MODE_BLY. interidad apphcation of the block.
iy 2 L] Parameter el - double cick on this e to open
ACTLIAL o = )
Epcaumso Zuto| D05 m the editor fos this parametes
MORMAL o o
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STATUS
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SUESTATUS @
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@ HEAD_TYPE 000 [~ ]
o

@ TEMP_OFFSET_CORRECTION 0°C

<

‘wirite Changes
“ >
PARAMETER "HEAD_TYFE™: -l
read data object. . success
PARAMETER “TEWP_OFFSET_CORRECTION":
read data object. . success (08:44:45)
Status {DowrloadErrors \AssignmerihLive List/ | « | »
Ready 07/06{10 08:44:43

Figure 3-6. Example of help information for selected block parameter

The Status Window  The status window displays the current status of the configurator and
contains several tabs.

e Status tab: Click to view live updates of what the configurator is
doing.

e Download tab: Click to view all the status information for the last
configuration download to the bus. This data is updated when the
next download occurs.

e Errors tab: Click to view all recent I/O errors, project configuration
errors, and warnings. If you double-click on an error, a window
opens that displays the cause of the error, allowing you to fix it.
Reference the NI-FBUS user manual for a list of error messages and
warnings.

e Assignment tab: Click to view the status information for the process
of assignment when taking a link online. This data is updated when
an offline link is taken online.

o Live List tab: Click to view the live links and devices on the
network. By default, only the online links and devices are shown.
Check the Show offline link box to view offline links/devices.

Thermo Fisher Scientific DensityPRO with FOUNDATION™ fieldbus Application Guide  3-7



The NI-FBUS Configurator

Configurator Basics

Configurator
Basics

Note Information on specific tasks, such as setting up level or performing a
calibration can be found in the remainder of this manual. The purpose of
this section is to provide general instructions on how to use the NI-FBUS
Configurator with the DensityPRO. A

Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

In general, commissioning the gauge consists of:

1. Installing the application software, and downloading the DensityPRO
DD.

2. Setting block parameters for gauge operation (setting the time constant,
the minimum and maximum level, the current output range, etc.).

3. Creating a block diagram or control strategy and the execution

schedule.
4. Configuring alarms.

5. Downloading the project to the device.

As mentioned earlier, the DensityPRO with FOUNDATION fieldbus
supports six blocks: one resource block, one transducer block, and four
function blocks. When you double-click on a block in the configuration
tree, the block configuration window opens as a floating window over the
main screen. You can enlarge/resize the window to improve viewing,.

The Al block configuration window is shown below as an example for this
section.

Note Additional information on the block configuration window, such as
how to create customized tabs, can be found in the configurator user
manual. A
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The NI-FBUS Configurator
Configurator Basics

*| DensityPRO 085100079 : ANALOG... [2 |[B][]
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ANAOGNPUT |3 3§ % & 2 8¢ mm @ |—Configuration block window toolbar
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Figure 3-7. Block configuration window

Block Modes The gauge supports three block modes: Automatic (AUTO), Manual
(MAN), and Out of Service (OOS).

Automatic mode is the normal operating mode of the block. In this mode,
the block uses a local set point value in the normal block algorithm to
determine the output value.

In Out Of Service mode, the block is disabled. This mode is typically used
during block configuration. When a block is placed into OOS mode, its
output is held at the last value.

In Manual mode, the block output is set by the operator through the
interface device.
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Using Menus &  The preferred way to configure the device is to use menus and methods.

Methods

The NI-FBUS Configurator supports user menus.

Access the menus by going to AL TRANSDUCER > Root Menu.

* DensityPRO.

(4 TRANSDU DB 1 Setup
I 13
7 Pesocic U I8 2 Standardization

3 Gauge Calibration ¥

oos [""‘_“ 08 4 Alarm ]

085100079 : AL_TRAN... [= |[B]5]

'ER 2B Bnn e

@ TEMP_DFFSET_CORRECTION 0°'C

<

Process | 11 B 5 Actions ¥ & | Tiends | Othess | Methods |
Paramster T8 6 Disg/Service : Typa LE:
E @ MODE_BLK
TARGET Auto m
ACTUAL ] @
PERMITTED Hado | D05 ]
HNORMAL Auto @
B @ PRIMARY_VALUE
gvn:.ui o o
STATUS
DUALITY =@
SUBSTATLIS @
LIMITS @
@ HEAD_TYPE 000 =]
[

WieChorges |

Read Al

Figure 3-8. The Root Menu

Menu Level 1

Menu Level 2

The table below lists the items contained within each menu.

Table 3-4. Root Menu items

Menu Level 3

1 Setup

1 Density Setup

Density Setup

2 Time Constant

Time constant setup

3 Temp. Compensation
Setup

Temperature Comp. Setup

4 Other meas assign modify

Other meas assign modify

5 View other measurement

Vliew other measurement

2 Standardization

Standardization

3 Gauge Calibration

GAUGE CALIBRATION

4 Alarm

Alarm Setup

5 Actions 1 System Restart System Restart
2 Erase All Entries Erase All Entries
3 Clear All Alarms Clear All Alarms
4 Clear All Holds Clear All Holds
6 Diag/Service 1 Current Qutput Current output setup

2 Loop Test

Loop test

3 Trim Analog Output

Trim analog output
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Menu Level 1 Menu Level 2

6 Diag/Service, cont. 4 Device Status

Menu Level 3

Device status

5 Al_Transducer Parameters | All parameters related to the

instrument

Following is an example of how to use the menus.

1. Go to AL TRANSDUCER > Root Menu > 5 Actions > 4 Clear All

Holds > Clear All Holds.

2. The Clear All Holds screen will appear under the Methods tab. Click

Next or press Enter when you are ready to continue. The configurator
will display that the task has been completed.

|~ DensityPRO 085100079 : Al_TRAN.... [Z|[B][K)

7| DensityPRO 085100079 : AI_TRAN... [= |[E][&)
Apply Valies  Root Merw Apply Values  Root Menu

e — = = R R R faTransoucer |2 B ¥R E B % EE @
= = I~ Pedodic Updates  [2[sec) =]

008 [[auo 005 [[Auo

Process | 110 Config | Alams | Diagnostics | Trends | Others  Methods Process | 140 Config | Alams | Diagnostics | Trends | Others  Methods

Clear All Holds

Clear All Holds

Varning — This function can affect the device output

Loop should be removed from automatic control Warning — This function can affect the device
output . Loop should be removed from automatic

Zenbrod

HOTE-Loop may be returned to automatic control

Method execution has completed

Figure 3-9. Clearing all holds using menus

‘Write Changes Read Al
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3-12

Directly Editing

Parameters
Caution The preferred configuration method is to use menus as described
in the previous section; however, you can edit a parameter directly if your
host does not support menus. Take care when modifying parameters
directly. If you change the value for one parameter, you may need to
change the value for other parameters. A
To edit a parameter, click on it. In some cases, you set the parameter value
by selecting from a drop-down box. For other parameters, you enter the
value. When you change a parameter, an asterisk appears by the name.
sityPRO. N... ﬁTﬂﬂl 7| DensityPRO 085100079 : ALTRAN... [ )[B]&]
. Apply Yalugs  Root Menu
rasouEn B8 8BBS00 0 | maemie e @683 e s )
W PeiodicUpdstes  [2[ec) =] — z
™ Periodic Lpdates 2 (sec) 3
005 || Auto
Puocess | 1/0 Config | Alems  Diagnostics | Trends | Others | Methods | ﬁl i
[ Value Type A Prucsssi 1/0 Config] Alarms  Diagnastics lTlsndsi Dlhgrs] Mslhudsi
B @ PRIMARY_VALUE ) Val T A
&g?k%s o - Elam:;mmv_vmus . =
E QuALITY o ;VALUE [+ ]
SUBSTATUS -] STATUS
LIMITS =] EEUALITY m
- DPRO_CMD Ready = | Emﬁ?;“us g
@ COUNTOOWMN_TIMER EE%:: o i @ DFRO_CMD Reads -
@ TC_PRIMARY Start CAL cycle ar .
i nﬁgﬂ:: :2: @ COUNTDOWN_TIMER FBDisy
Seert ti T PR —
@ DETECT_SIG_VALUE Hold densily al dendaghold mode valus|
@ SOLID_ATTEN_COEF E;:ld:"uzzrfl output at FAULT HIGH @ STD_VALUE 23950 m
@ FROCESS_TEMP_LEARNED AL oo Aremaie Tooe b b @ DETECT_SIG_VALUE o
2 Use Primary Time Const > < >
Erase all entries (EVERYTHING]
‘Write Changes E‘rt:::rél alarm action assignments ‘Wiite Changes Readal
Hold current output at FAULT LOW  f——
Start Standardizaban
Swalch current out to alt/pri mode:
ABORT Standasdization
Erase Protected NVRAM
Refrech
Selecting from a drop-down list Entering a value
Figure 3-10. Examples of modifying parameters using the NI-FBUS Configurator
There are two ways to save your changes, depending on what you want to
do:
e If you want the changes to take effect immediately, click the
71 Write/Save button in the configuration window toolbar. You can
also click the Write Changes button on the bottom of the block
configuration window.
e Make other changes and save them all at once by clicking the
Write/Save All button in the configuration window toolbar. If you
L

do not click the Write/Save All button, you can make all the
changes take effect when you download the project by checking the
Werite Contained Block Parameters box. Download the
configuration is explained further in “Saving & Downloading the

Configu

DensityPRO with FounpATION™ fieldbus Application Guide

ration”.

Thermo Fisher Scientific



Updating
Parameters

Function Block
Application

Thermo Fisher Scientific

The NI-FBUS Configurator
Configurator Basics

After saving, the asterisk that appeared by the modified parameter will
clear, indicating that the changes have been accepted.

Note If you do not want to save the changes you made, you can undo
them by clicking the Read All button at the bottom of the configuration
window. This causes a read of the parameter values stored in the device
(before the changes). a

There are several ways to update the parameter values:

e To update all parameters in the block configuration window you
have open, click the Read All/Set Defaults icon in the toolbar.
(This may also be accomplished by clicking the Read All button at
the bottom of the window.)

e To update a single parameter, click on it and then click the Read
Selected/Set Selected Default icon.

e To update all parameters in the block configuration window
automatically, click the Periodic Updates box and select a poll rate.

Typically, once you have configured block parameters, you can create a
block diagram (or control strategy). Following is an example of how to
create a basic connection to the Al block using the Function Block

Application (FBAP).

1. Double-click the Function Block Application object in the
configuration tree. The FBAP grid opens in the middle frame.

2. For this example, connect the AO block of another device on the
network to the DensityPRO Al block. Click on the DensityPRO Al
block and drag it to the FBAP grid.
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£ NI-FBUS Configurator(Ver 3.2.3) : FCP1 - [interface0.0 : Function Block Application] |[F [
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Figure 3—-11. DensityPRO Al block on the FBAP grid

3. Click on the AO block of the other device and drag it to the FBAP
grid.

4. Connect the OUT of the DensityPRO Al block to the CAS IN of the
3 other device’s AO block. To do this, click the Wiring Tool icon on the
FBAP toolbar. Click on the OUT terminal of the Al block and then
click on the CAS IN terminal of the AO block.

Note An alternative to wiring blocks together is to use one of the templates
provided by the NI-FBUS Configurator. Reference the NI-FBUS
Configurator user manual for more information. Additional information
on the FBAP tools can also be found in the configurator manual. A

5. Check the execution schedule (Loop Time) and make necessary
adjustments.

6. Repeat this process for each loop you want to make. Upon completion,
you can see the schedule in its entirety (view execution order of all the
loops) through the Schedule object in the configuration tree. (For more
information on the Schedule object, reference the configurator user
manual).
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7. Now you are ready to download the configuration.

Saving & After setting block parameters, creating a block diagram and schedule, and
Downloading the configuring alarms, you should save the configuration. From the main
screen of the configurator, click File > Save.

Configuration
Now you are ready to download the configuration project to the

DensityPRO. Follow the procedure below to do so.

g 1. Click the Download Project icon in the main screen toolbar. The
Download Configuration dialog box opens.

Download Configuration

g = . Chooze object to download

&= interfacel-0

I ‘write Cantained Block Parameters
Iv Clear Devices
g v Automatic Mode Handling

© <
..&_ I Werify and Diff Configuration  Link Masters. .

Fieady for download.

D ownload | Cloze | |

Figure 3-12. Download Configuration dialog box

2. Make the appropriate selections. In general, you should always select
Clear Devices and Automatic Mode Handling.

a. Write Contained Parameters: Causes the parameter changes you
made in each block to take effect.

b. Clear Devices: Clears the existing configuration of the DensityPRO
before downloading.

c. Automatic Mode Handling: Automatically places the blocks into
OOS mode during the download process and returns them to
AUTO mode when the download is complete. If you do not make
this selection, you will be prompted to do this manually.

d. Verify and Diff: Causes the configurator to upload the
configuration from the devices after a download. It then compares
the uploaded information to the file in the configurator and
generates a report of any differences between the two files.

Thermo Fisher Scientific DensityPRO with FounpATION™ fieldbus Application Guide  3-15



The NI-FBUS Configurator
Configurator Basics

3. Itis assumed that you have already designated the link master and set
the Link Active Schedule for devices on the network. If you have not,
click the Link Masters button to access the Network Parameters dialog
box. For information on link masters, the Link Active Schedule, and
setting network parameters, refer to the configurator user manual.

4. Click the Download Project button to start the download. This may
take several minutes. When finished, a dialog box appears informing
you that download is complete.

Other Configurator  Once you have downloaded the configuration to the DensityPRO, you can
Functions  use the NI-FBUS Configurator to do other things.

Note Refer to the NI-FBUS user manual for more information on the
functions introduced in this section. If you are not using the NI-FBUS
Configurator, reference the documentation that came with your host
system. A

Monitor Parameters

You can view a graphical representation of the updates to the block
parameters. This is referred to as monitoring the parameters. Use the
Monitor Mode icon on the FBAP toolbar.

Quick Verify

A quick verify compares the parameters on the bus to those in the
configuration for a selected device or block. Right-click on the device or

block and select Simple Verify Configuration.

Print a Configuration

The NI-FBUS Configurator provides several options for printing a

configuration project. Go to File > Print and make the desired selections.
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Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

Note This chapter provides setup instructions using the NI-FBUS
Configurator menus, as this is the preferred way to configure the
instrument. Move from one step to the next in the configurator method
window by clicking Next or pressing Enter. If your host does not support
menus, reference Appendix C for a list of DensityPRO parameters. A

The second level menus for the Setup menu are listed below:

Density Setup

Time Constant

Temp. Compensation Setup
Other meas assign modify

View other measurement

Note This chapter gives you an overview of the Setup menus. For
additional information, reference the DD flow blocks in Appendix E and
the DensityPRO user guide (P/N 747784). A

DensityPRO with FounDATION™ fieldbus Application Guide
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DenSity Setup The Density Setup menu takes you through the steps required to configure

the density measurement. These steps are listed below.
1. Go to AL_TRANSDUCER > Root Menu > Setup > 1 Density Setup.
2. When prompted, remove the loop from automatic control.

3. Source Head Geometry: Scroll through list of source head models, and
select the model used on your gauge. The source head model is used to
set a “geometry factor” to tune the gauge’s performance.

4. Material Type: Select the correct material type: slurry, solution, single
phase, or emulsion.

5. Carrier Gravity and Solids Gravity: Additional menu items are
displayed to enter the required specific gravity values for that material
type as listed below.

a. Ifyou selected slurry, enter the carrier gravity and solids gravity.
b. If you selected solution, enter the solvent gravity and solution type.

c. Ifitis either unnecessary or impossible to describe your process
material as a slurry, emulsion, or solution, select single phase.

d. Ifyou selected emulsion, enter the specific gravity of the carrier
liquid (Fluid_1_gravity) and suspended liquid (Fluid_2_gravity) in
g/cc.

6. Primary Measurement: The available measurements depend on
selection of material type selected. The example below shows the
measurements available for slurry.
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10.

11.
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Figure 4-1. Example of primary measurement types

DensityPRO Setup
Density Setup

Structural Units: Select the desired units for the inside diameter of the

process pipe.

Pipe Inside Diameter: Enter the inside diameter of the pipe.

Meas #1 Reading for 20 mA Output: Enter the primary measurement

value that represents the maximum current output.

Meas #1 Reading for 4 mA Output: Enter the primary measurement

value that represents the minimum current output.

Density setup is complete.
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Time CO nstants  To set the primary and alternate time constants using the NI-FBUS

Configurator:

1. Go to AL TRANSDUCER > Root Menu > 1 Setup > 2 Time

Constant > Time constant setup.
2. Remove the loop from automatic control as prompted.
3. Primary Time Constant value: Set the primary time constant.
4. Alternate Time Constant value: Set the alternate time constant.

5. Current Time Constant: Enter 1 to use the primary time constant or 2
to use the alternate.

6. Time constant setup is complete.

Temperatu re If temperature compensation is required, access the Temp. Compensation
- S .
Compensation " ™™
Setup

Setup consists of the following steps:

1. Go to AI_TRANSDUCER > Root Menu > Setup > 3 Temperature
Comp. Setup > Temp. Compensation Setup.

2. Remove the loop from automatic control.
3. Temp. Input Source: Select the source of the temperature input signal.

4. Temp. hold constant: Enter the temperature hold constant if you
selected Manual entry above.

5. Temperature comp polynomial: Choose a user defined or predefined
temperature compensation polynomial. The gauge uses polynomial
equations to compute the change in density of the process material(s) as
a function of the change in temperature relative to the reference
temperature. If you select user defined, temperature compensation
polynomials are defined based on the material type selected.
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10.

11.

12.

DensityPRO Setup
Temperature Compensation Setup

Ref. Temperature: Enter the reference temperature. The gauge
performs all of its temperature compensation calculations relative to the
reference temperature.

Ref Density: The density of a material at the reference temperature is
called its reference density. The density values specified in the Density
Setup menu are used. For example, the carrier gravity and the solids
gravity values are used when the material type is slurry.

Coefficients A/B/C for equation 1: If you selected user defined
polynomials, enter three coefficients (A, B, C) for equation 1.

Enable/disable temp comp: Choose whether equation 1 will be used
for standardization. If you standardize with the pipe full and the
temperature is different than the reference temperature, the density
during the standardization measurement may be significantly different
from the reference density value (e.g. the carrier gravity for slurry) that
is assumed to correspond to the standardization. To correct for this,
select to use temperature compensation. With this setting, the gauge
uses the process temperature measured at the end of the standardization
cycle and the temperature compensation polynomial to normalize the
standardization measurement to what it would have been at the
reference temperature.

Coefficients A/B/C for equation 2: Enter three coefficients (A, B, C)
for equation 2.

Temperature error correction: Enter the temperature offset correction.
For example, if the gauge consistently reads 2°C over the actual process
temperature, enter an offset correction of —2°C.

Temperature compensation setup is complete. Loop may be returned to
automatic control.

DensityPRO with FounDATION™ fieldbus Application Guide  4-5



DensityPRO Setup
Other Meas Assign Modify

Other Meas The Other meas assign & modify menu allows you to configure other
Assi gn Mo dify measurements and modify existing ones.

1. Go to AL TRANSDUCER > Root Menu >Setup > 4 Other meas
assign modify > Other meas assign modify.

2. When prompted, remove the loop from automatic control.

3. Select measurement: You can configure three measurements in
addition to the primary measurement. Enter which measurement you
want to configure or modify.

4. Reading represented by measurement: Select the readout type for the
measurement.

5. Unit selection/Time selection: Select the unit and/or time unit as
required.

6. Reading for high end/low end values: Enter the values that represent
the highest and lowest measurement readings.

7. Measurement configuration/modification is complete. The loop may be
returned to automatic control.

View Other The View other meas item allows you to view other configured

measurements and their current value.
Meas
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Chapter5
Standardization & Calibration

This chapter provides an overview on how to use the NI-FBUS
Configurator menus to standardize and calibrate the DensityPRO.

Note This chapter provides setup instructions using the NI-FBUS
Configurator menus, as this is the preferred way to configure the
instrument. Move from one step to the next in the configurator method
window by clicking Next or pressing Enter. If your host does not support
menus, reference Appendix C for a list of DensityPRO parameters. A

Note For detailed discussion on standardization and calibration, reference

the DensityPRO user guide (P/N 717784). A

Follow this procedure to perform standardization:

1. Put the gauge head and pipe in one of the following standard
configurations. Use the exact same standard configuration every time
you standardize.

a. Pipe full of carrier
b. Pipe empty
c. Pipe full of process

2. Open the source shutter.

3. In the NI-FBUS Configurator, go to AL TRANSDUCER > Root
Menu > 2 Standardization > Standardization.

4. When prompted, remove the loop from automatic control.
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5. Std Cycle Time: Specify the number of time constant periods used for
the standardization. If the time constant is 128 seconds and you enter 2
here, the standardization cycle will last 256 seconds (2 x 128 seconds).

6. Standardization on: Enter the number that describes how the
standardization will be performed: on a pipe full of carrier (1), an
empty pipe (2), or a pipe full of process (3).

7. Start Data Cycle: Enter 1 to start standardization.

8. Once standardization begins, the time remaining will be displayed. You
can interrupt the cycle at any time by clicking Abort.

9. When the time remaining is 0 seconds, click Next two times. The
software will display that the cycle has been completed. Click Write
Changes.

Perform The steps below describe how to calibrate the gauge.
Calibration

1. If necessary, set up the gauge.
2. Standardize according to “Perform Standardization”.

3. Fill the pipe with process material at a density in the range of interest.
Keep the process density as stable as possible during the calibration
measurement, and be ready to take samples of the material during the
calibration cycle.

4. In the NI-FBUS Configurator, go to AL TRANSDUCER > 3 Gauge
Calibration > GAUGE CALIBRATION.

5. When prompted, remove the loop from automatic control.

6. CAL Cycle Time: Specify the number of time constant periods used for
the standardization. If the time constant is 128 seconds and you enter 2
here, the standardization cycle will last 256 seconds (2 x 128 seconds).

7. Start Calibration Cycle: Enter 2 to begin the calibration cycle.

5-2 DensityPRO with FOUNDATION™ fieldbus Application Guide Thermo Fisher Scientific



Standardization & Calibration
Perform Calibration

8. During the cycle, take several samples of the process material and
determine the average of the sample densities.

9. CAL/STD ratio from latest CAL: When the calibration cycle is
complete, the ratio of the last calibration measurement to the
standardization value is displayed.

10. Use latest CAL value for CAL point 1: To use the calibration value for
CAL point 1, enter 2. Enter 1 if you do not want to use the value for
CAL point 1.

11. Calibration is complete and the loop can be returned to automatic
control.
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Chapter 6
Alarm Setup

This chapter provides an overview on how to use the NI-FBUS
Configurator menus to configure alarms.

Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

Note This chapter provides instructions using the NI-FBUS Configurator
menus, as this is the preferred way to configure the instrument. Move from
one step to the next in the configurator method window by clicking Next
or pressing Enter. If your host does not support menus, reference Appendix
C for a list of DensityPRO parameters. A

Note For detailed discussion on alarm parameters, reference the

DensityPRO user guide (P/N 717784). A

1. In the NI-FBUS Configurator, go to AI_TRANSDUCER > 4 Alarm >
Alarm Setup.

2. When prompted, remove the loop from automatic control.

3. Select alarm number to set up: You can configure up to eight alarms.
Enter the alarm number you want to configure now.

4. Alarm x set point: Enter the set point (the measurement value at which
the alarm is activated).

5. Alarm x clear mode: Select a clear point or deadband configuration. A
clear point is the exact measurement value at which the alarm is cleared.
A dead band specifies the span between the set point and the implicit
clear point.

6. Alarm x clIr point/deadband: Enter the clear point or deadband value.
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7. Alarm x set action: Select the action used to indicate that the alarm has
been triggered.

8. Alarm setup is complete and the loop can be returned to automatic
control.
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The Actions menu provides access to frequently used commands. The
commands are listed below.

e System Restart: Restarts the system, erasing temporary memory.
User-entered setup data is not affected.

e Erase All Entries: Erases previously entered set up data. All settings
except for the serial communication settings are reset to factory

defaults.

e Clear All Alarms: Acknowledges, clears, and resets all alarms. Alarm
actions are cleared, but the setups are not affected. Alarms actions
are re-established when the alarms activates again.

e Clear All Holds: Clears all holds currently in effect.
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Chapter 8
Diagnostics

This chapter provides on the Diag/Service menu in the NI-FBUS
Configurator root menu. The Diag/Service menu provides access to the
Current Output, Loop Test, Trim Analog Output, Device Status, and
Al_Transducer Parameters items.

Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

Note This chapter provides instructions using the NI-FBUS Configurator
menus, as this is the preferred way to configure the instrument. Move from
one step to the next in the configurator method window by clicking Next
or pressing Enter. If your host does not support menus, reference Appendix
C for a list of DensityPRO parameters. A

Note For detailed discussion on any of the diagnostic items discussed,

reference the DensityPRO user guide (P/N 717784). A

The steps below describe how to configure the current output.

1. Go to A_TRANSDUCER > Root Menu > 6 Diag/Service > 1
Current Output > Current output setup.

2. When prompted, remove the loop from automatic control.

3. Max current output: Enter the maximum current output (between 0

and 20.5 mA).

4. Min current output: Enter the minimum current output (between 3.8
and 20 mA).

5. Current output hold mode value: Enter the hold mode value for the
current output. The value is entered as a percentage of the maximum
current output.
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6. Current output setup is complete. The loop may be returned to

automatic control.

I_O()p Test The Loop Test function allows you to manually manipulate the analog

output to a selected constant output value.

1. In the NI-FBUS Configurator, go to AL TRANSDUCER > Root
Menu > 6 Diag/Service > 2 Loop Test > Loop test.

2. When prompted, remove the loop from automatic control.

3. There are four selections shown.
a. Selection 1 —4 mA: Enter 1 to fix the device at 4 mA.
b. Selection 2 — 20 mA: Enter 2 to fix the device at 20 mA.
c. Selection 3 — Other: Enter 3 to fix the device at a value you enter.
d. Selection 4 — End: Enter 4 to exit the menu.

Enter the selection you want.
4. When prompted, confirm the selection you made.

5. The method has completed. Loop may be returned to automatic
control.

Trim Analog The trim analog output function allows you to confirm that the current
outp ut output value of the reference meter can be adjusted to match the set value.

1. In the NI-FBUS Configurator, go to AL_TRANSDUCER > Root
Menu > 6 Diag/Service > 3 Trim Analog Output > Trim analog
output.

2. When prompted, remove the loop from automatic control.

3. Connect the reference meter. The output will be set to the minimum
current value.

4. Enter meter value: Enter the value displayed by the reference meter.
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Thermo Fisher Scientific

10.

Diagnostics
Device Status

Does set output x mA equal readout device?: Confirm the set output
and reference meter reading are the same. Enter 1 to continue to the
next step. If you need to modify the value again, enter 2.

If you entered 1 in the previous step, the software will show that the
current output is being set to maximum.

Enter meter value: Enter the value displayed by the reference meter.

Does set output x mA equal readout device?: Confirm the set output
and reference meter reading are the same. Enter 1 to continue to the
next step. If you need to modify the value again, enter 2.

If you entered 1 in the previous step, the software will show that the
field device is being returned to its original output.

Click Next to finish the process. The loop may be returned to
automatic control.

When you select the Device Status item from the Diag/Service menu, any
alarms or bad flags (indicators that the gauge has been incorrectly

configured) are displayed. Click Next to view each one. An example is
shown below.

1 DensityPRO

r

Apply Values  Root Meru

EE— = R R =)

oos [

Frocess | 10 Conig | Alams | Diagnostics | Trend: | Othess  Methods

085100079 : AL_TRANSDUCER ... [= ][]

| EEET |

Device status

FB IF to device comm error
4ll Status information has been displayed

Figure 8-1. Device status example
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Troubleshooting

Chapter 9
Troubleshooting & Service

Fieldbus The table below provides troubleshooting for problems related to the

fieldbus network.

Table 9-1. Fieldbus troubleshooting

Description of Problem

Possible Cause

Possible Solution/Corrective Action

Al_TRANSDUCER block will not go
into AUTO mode (stays in 00S mode).

Configuration is incorrect or
incomplete.

Verify configuration (reference your host
documentation).

The resource block is in 00S mode.

Set the resource block mode to AUTO.
Other blocks cannot be in AUTO mode if
the resource block is in 00S mode.

A device is not shown in the
configuration tree.

Communication parameters are
incorrect.

Verify communication parameters
(reference your host documentation).

A function block alternates between
MAN and AUTO modes. Status of the
input parameter is Bad::No comm.

There is not enough time between the
function block and communication
schedules.

Edit the schedule to add more time
between the function block and
communication schedules (reference
your host documentation).

A block parameter cannot be modified.

The parameter is read-only.

If the parameter is read-only, it may not
be modified.

The block operating mode is incorrect.

Certain parameters can only be modified
in 00S or MAN modes (reference your
host documentation).

The data is out of range.

Enter data within the specified range.

There is no power to the device.

Check ALARM_STATUS_FLAGS_3. If FB
IF to device comm error is displayed,
check the DensityPRO CPU.

A device does not transmit alarms.

Alarms are not configured.

Configure alarms (reference your host
documentation).

Block alarm active parameters.

Invalid feature selection.

The ANALOG_INPUT block units do not
match the transducer block units.

Thermo Fisher Scientific
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Troubleshooting & Service
Contact Information

Contact
Information

Warranty

9-2 DensityPRO with FOUNDATION™ fieldbus Application Guide

The local representative is your first contact for support and is well
equipped to answer questions and provide application assistance. You can
also contact Thermo Fisher directly.

1410 Gillingham Lane
Sugar Land, TX 77478
USA

Tel: +1 713-272-0404
Fax: +1 713-272-2272

14 Gormley Industrial Avenue
Gormley, Ontario

LOH 1G0

CANADA

Tel: +1 905-888-8808

Fax: +1 905-888-8828

lon Path, Road Three
Winsford, Cheshire, CW7 3GA
UNITED KINGDOM

Tel: +44 (0) 1606 548700

Fax: +44 (0) 1606 548711

Room 1010-1019 Ping An Mansion
No 23 Jing Rong St

Beijing 100032

CHINA

Tel: +86 (10) 5850-3588

Fax: +86 (10) 6621-0847

A-101, 1CC Trade Tower
Senapati Bapat Road
Pune 411 016

INDIA

Tel: +91 (20) 6626 7000
Fax: +91 (20) 6626 7001

On the Web
www.thermoscientific.com

Thermo Scientific products are warranted to be free from defects in

material and workmanship at the time of shipment and for one year
thereafter. Any claimed defects in Thermo Scientific products must be
reported within the warranty period. Thermo Fisher Scientific shall have
the right to inspect such products at Buyer’s plant or to require Buyer to
return such products to Thermo Fisher plant.

In the event Thermo Fisher requests return of its products, Buyer shall ship
with transportation charges paid by the Buyer to Thermo Fisher plant.
Shipment of repaired or replacement goods from Thermo Fisher plant shall
be F.O.B. Thermo Fisher plant. A quotation of proposed work will be sent
to the customer. Thermo Fisher shall be liable only to replace or repair, at
its option, free of charge, products which are found by Thermo Fisher to be
defective in material or workmanship, and which are reported to Thermo
Fisher within the warranty period as provided above. This right to
replacement shall be Buyer’s exclusive remedy against Thermo Fisher.

Thermo Fisher shall not be liable for labor charges or other losses or
damages of any kind or description, including but not limited to,
incidental, special or consequential damages caused by defective products.
This warranty shall be void if recommendations provided by Thermo
Fisher or its Sales Representatives are not followed concerning methods of
operation, usage and storage or exposure to harsh conditions.

Thermo Fisher Scientific



Thermo Fisher Scientific

Troubleshooting & Service
Warranty

Materials and/or products furnished to Thermo Fisher by other suppliers
shall carry no warranty except such suppliers’ warranties as to materials and
workmanship. Thermo Fisher disclaims all warranties, expressed or
implied, with respect to such products.

EXCEPT AS OTHERWISE AGREED TO IN WRITING BY Thermo
Fisher, THE WARRANTIES GIVEN ABOVE ARE IN LIEU OF ALL
OTHER WARRANTIES, EXPRESSED OR IMPLIED, AND Thermo
Fisher HEREBY DISCLAIMS ALL OTHER WARRANTIES,
INCLUDING THOSE OF MERCHANTABILITY AND FITNESS
FOR PURPOSE.
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Appendix A
Ordering Information

Table A-1. System ordering information

Code Model

DPRO DensityPRO integrated gamma density system

Code High Performance Input Power

1 115/230 Vac + 10%, 50/60 Hz

2 24 \dc

Code Relays

R Two SPDT relay contacts rated 10 amps @ 115 Vac

N No relay contacts

Code 4-20 mA output

L Isolated, loop-powered (Namur compliant 700 ohm load max.)

S Isolated, self-powered (Namur compliant 700 ohm load max.)

Code Detector Approvals

N4 Non-hazardous model 9719-Type 4, CSA/C-US

XP Hazardous model 9720-XP-Class I, Div 1, CSA/C-US, Type 4, ATEX IP65

Code Detector Enclosure

D Dual chain mount

B Base plate mount (required if pipe saddle option selected or for wall
mounting)

W Base plate mount water-cooled (pipe saddle required)

Code Mounting Hardware

NO No mounting hardware

DS Dual-chain 2" steel pipes (dual chain mounting required)

DM Dual-chain 2.5"—18" pipes (dual chain mounting required)

DL Dual-chain 20"-36" pipes (dual chain mounting required)

1.5 Pipe saddle for 1.5" or 2.0" pipes

XX Pipe saddle for 3"— 16" pipes (available pipe sizes: 3", 4", 5", 6", 8",

10,12, 14", 16")
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Ordering Information

XX Pipe saddle for 18"—42" pipes (available pipe sizes: 18", 20", 22", 24",
26", 28", 30", 36", 42")
Code Backshield Option
B Detector with backshield (NEMA 4 only)
N No backshield
Code Temperature Compensation
N No selection
T Temperature compensation board
R Temperature compensation with RTD
Code Communications
0 No selection
A Thermo Scientific 9734 HHT
E HART communication module
F FOUNDATION fieldbus module
Code Accessories (optional)
L Lg SS tag (3.3" x 2.5") wired
R RJ-11 modular connector jack
D Model 9723 backlit LCD
T Pipe tabs (pipe saddles only)
Table A-2. Spare parts
Part Number Description
886631 Complete electronics chassis
886670-2 CPU assembly
NDMI-PWR001 AC power supply assembly without relays
NDMI-PWR002 AC power supply assembly with relays
886595-1 Kit, 4-20 mA, isolated, self-powered
885882-1 Backlit display PCB assembly (circuit board only)
886609 Temperature compensation circuitry assembly
OPR0101C Complete electronics chassis with AC power supply, no relays; tested
OPR0101D Complete electronics chassis with AC power supply, with relays; tested
DPROCBLKIT Kit, complete set of DensityPRO connection cables (excluding HART)

A-2 DensityPRO with FOUNDATION™ fieldbus Application Guide
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Appendix B

Specifications

Results may vary under different operating conditions.

Table B-1. Performance specifications

System performance

From £ 0.0001 gm/cc, depending on application

Table B-2. Gamma ray source

Source type

Cs-137 or Co-60, both stainless steel doubly encapsulated

Size

10-10,000 mCi Cs-137 or 1,000-3,000 mCi Co-60

Source housing

Carbon steel or stainless steel, lead filled, polyurethane
painted

Two-position shutter, locks in OFF (closed) position

Table B-3. Integrated transmitter-detector

System architecture

Multiprocessor based electronics provides uninterrupted
output during data entry and system interrogation

Surface mount technology provides high degree of reliability

All user data is doubly stored in non-volatile memory with no
battery backup required

Detection type

PVT plastic scintillator with wide dynamic range; PVT resists
shock and moisture damage

Detector stabilization

Electronic control without heater stabilization for optimum
performance

Enclosure construction

Carbon steel polyurethane painted

Approvals — Model 9719A

FMRC approved dust-ignition proof in Class II, Div. 1, Groups E,
F, and G; suitable for Class Ill, Div. 1 hazardous locations,
indoor and outdoor NEMA 4.

CSA approved dust-ignition proof in Class II, Div. 1, Groups, E,
F, and G; suitable for Class llI, Div. 1 hazardous locations,
indoor and outdoor CSA ENCL 4.

DensityPRO with FOUNDATION™ Fieldbus Application Guide  B-1



Specifications

Approvals — Model 9720A | FMRC approved explosion proof in Class I, Div. 1, Groups B, C,
and D; Class II, Div. 1, Groups E, F, and G; suitable for Class lll,
Div. 1 hazardous locations, indoor and outdoor NEMA 4.

CSA approved explosion proof in Class I, Div. 1, Groups B, C,
and D; Class II, Div. 1, Groups E, F, and G; suitable for Class lll,
Div. 1 hazardous locations, indoor and outdoor CSA ENCL 4.

Power 115/230 Vac + 10%, 50/60 Hz or 24 Vdc
Operating temperature -40°C to +60°C (-40°F to +140°F) ambient

Table B—4. Outputs/Inputs

Current outputs Standard: 4-20 mA isolated, loop-powered into 700 ohms,
field scalable
Optional: 4-20 mA isolated, self-powered into 700 chms, field
scalable

Serial outputs RS485 half-duplex, RS232 full duplex

°  Fieldbus: A Device Description (DD) for the
DensityPRO is available from the Fieldbus
@ Foundation website. The DD is a DD4 that is
interpreted by a host implementing DD

Services 4.x or higher.

Contact closure outputs 2X 115 Vac/28 Vdc SPDT at 10 amps (230 Vac SPDT at8 amps)

FOUNDATION

Inputs Flowmeter: 4—20 mA linear
Dry contact closure

Table B-5. Mounting Hardware

Gamma ray source Integral bolt-on bracket; compatible with chain or
saddle mount

Integrated transmitter/detector Single or dual chain universal mount, 2.5" to 36" (63.5
t0 914.4 mm)

Pipe saddle mount, 2" to 42" (50.8 to 1066.8 mm)
Pipe saddle with tabs for mounting on insulated pipes

Axial-mount hardware for Z pipe installations, 1" to 4"
(25.4t0 101.6 mm)
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Specifications

Table B-6. Optional Model 9723 local remote display

Display 2-line X 16-character backlit LCD
Qualifications CSA/C-US: Class I, Groups B, C, and D; Class Il, Groups E, F, G;
Class IIl; Type 4 Enclosure
ATEX:
12GExdIICT6

(Tamb -40°C to +60°C)
EN60079-0:2006 and EN60079-1:2007

Power Display powered from electronics

Installation site Maximum separation from electronics: 300 ft (91.4 m)

Table B-7. Programming

Fieldbus host, such as Provides the interface between the DensityPRO and other
National Instruments devices on a FOUNDATION fieldbus network.
NI-FBUS Configurator

Emerson 375/475 Field For gauge configuration and calibration. Communicates with
Communicator any DensityPRO via the current loop.

BEL202FSK standard.
Thermo Scientific Model For gauge configuration and calibration. Communicates with

9734 hand held terminal any DensityPRO via RS485 connector.

Provides upload / download of gauge configuration to/from PC
via RS232 interface.

Comm PC interface For interfacing with up to 32 DensityPRO units over RS485.
software RS485 / RS232 converter provided.
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Appendix C
DensityPRO Specific Parameters

The fieldbus parameters that are specific to the DensityPRO are

categorized as follows:

Command parameters: Used to issue commands to the device.
Status parameters: Display the internal status of the DensityPRO.

Configuration parameters: Used to configure the DensityPRO’s
operational modes.

Alarm parameters: Used to set up the gauge alarms.
Calibration parameters: Used to linearize gauge performance.

Alarm and Status Flags: Display information on the state of the
alarm.

Bad Flags: Indicate the cause of incorrect gauge configuration.

The parameter types are indicated in the table according to the
abbreviations below.

CMD: Command S: Status

CON: Configuration ALM: Alarm

CAL: Calibration ASF: Alarm and Status Flag

BF: Bad Flag
All DensityPRO parameters are located in the AI_ TRANSDUCER block
(AITB).

Note To make locating a parameter easy, they are listed alphabetically. A

Caution Take care when modifying parameters directly. If you change the
value for one parameter, you may need to change the value for other

parameters. A
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DensityPRO Specific Parameters

Table C-1. DensityPRO specific parameters

Parameter Type | R/W | Description

ALARM_STATUS_FLAGS_1 ASF | R Alarm and status flag set 1
Bit 0 - "Unused" Bit 16 - "Process Alarm 1"
Bit 1 - "Unused" Bit 17 - "Process Alarm 2"
Bit 2 - "Standardization mode Bit 18 - "Process Alarm 3"
active”
Bit 3 - "Calibration mode active" Bit 19 - "Process Alarm 4"
Bit 4 - "lump mode active" Bit 20 - "Process Alarm 5"
Bit5- "Unused " Bit 21 - "Process Alarm 6"
Bit 6 - "scan mode" Bit 22 - "Process Alarm 7"
Bit 7 - "X-Ray Safeguard Active " Bit 23 - "Process Alarm 8"
Bit 8 - "CAL Cycle aborted" Bit 24 - "Process Alarm 9"
Bit 9 - "FIFO Full" Bit 25 - "Process Alarm 10"
Bit 10 - "Current over max or under | Bit 26 - "Process Alarm 11"
min"
Bit 11 - "Power has been off" Bit 27 - "Process Alarm 12"
Bit 12 - "Hold(s) are active" Bit 28 - "Process Alarm 13"
Bit 13 - "Alternate time constant Bit 29 - "Process Alarm 14"
active”
Bit 14 - "Output on alternate Bit 30 - "Process Alarm 15"
measurement”
Bit 15 - "Keypad in use" Bit 31 - "Process Alarm 16"

ALARM_STATUS_FLAGS_2 ASF | R Alarm and status flag set 2

Bit 0 - " Safeguard Mode Armed"

Bit 16 - "Current output under min"

Bit 1 - "Unused"

Bit 17 - "RAM Memory Error"

Bit 2 - "Sensor Under Range"

Bit 18 - "PROM Checksum Error"

Bit 3 - "Sensor Over Range"

Bit 19 - " Protected memory checksum
error"

Bit 4 - "No STD since last power
off"

Bit 20 - "Primary nvram memory checksum
error"

Bit 5 - "System Fault"

Bit 21 - "Secondary nvram memory
checksum error"

Bit 6 - "Totalizer locked"

Bit 22 - "Primary and secondary nvram
checksum error”

Bit 7 - "Standardization difference"

Bit 23 - "NV Write Error”

Bit 8 - “HART communication error”

Bit 24 - “#1 Totalizer locked”
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Parameter Type | R/W | Description

ALARM_STATUS_FLAGS_2 ASF | R Alarm and status flag set 2

(cont).
Bit9 - “Temp ADC error” Bit 25 - “#2 Totalizer locked”
Bit 10 - “Flow ADC error” Bit 26 - "#3 Totalizer locked”
Bit 11 - "Current output over max” Bit 27 - “#4 Totalizer locked”
Bit 12 - "NV Erase failed” Bit 28 - "HART POLL fault”
Bit 13 - “NV Checksum Error” Bit 29 - “Unused”
Bit 14 - “Totalizer locked” Bit 30 - “Unused”
Bit 15 - “Totalizer high rate” Bit 31 - “Unused”

ALARM_STATUS_FLAGS_3 ASF | R Alarm and status flag set 3

Bit 0 - “HV Background Interpolator
Active”

Bit 16 - “FB IF to device comm. error”

Bit 1 - "Unused” Bit 17 - "Unused”
Bit 2 - "Unused “ Bit 18 - "Unused”
Bit 3 - "Unused “ Bit 19 - "Unused”
Bit4 - “Unused “ Bit 20 - “Unused”
Bit 5 - "A/D Converter Fault " Bit 21 - "Unused”
Bit 6 - “Unused” Bit 22 - "Unused”

Bit 7 - “Bad XRAY Threshold"

Bit 23 - "Unused”

Bit 8 - “MSG over run”

Bit 24 - "Unused”

Bit 9 - “Gain not yet stable”

Bit 25 - "Unused”

Bit 10 - "NV tot Fault”

Bit 26 - “Unused”

Bit 11 - “Cal Pt Pending”

Bit 27 - “Unused”

Bit 12 - "HV unstable”

Bit 28 - “I0UT Hold"

Bit 13 - "FBUFFER overrun”

Bit 29 - “IOUT Hold at min”

Bit 14 - "NV data changed”

Bit 30 - “IOUT Hold at max”

Bit 15 - "Unused”

Bit 31 - "IOUT Hold at other”

Thermo Fisher Scientific
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DensityPRO Specific Parameters

ALARMZ.

Parameter Type | R/W | Description
ALARM1 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for
ALARMN.
Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =0utput 1 to FAULT LOW
1 = Control relay 1 5= Output 1 to FAULT HIGH
2 =Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
ALARM2 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for

Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =0utput 1 to FAULT LOW
1 = Control relay 1 5= Output 1 to FAULT HIGH
2 =Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
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DensityPRO Specific Parameters

Parameter Type | R/W | Description
ALARM3 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for
ALARM3.
Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =0Output 1 to FAULT LOW
1= Control relay 1 5= 0utput 1 to FAULT HIGH
2 = Control relay 2
SET_POINT The pracess level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
ALARM4 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for

ALARMA4.

Sub-parameter

Description

ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =Qutput 1 to FAULT LOW
1 = Control relay 1 5= 0utput 1 to FAULT HIGH
2 =Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND

Thermo Fisher Scientific
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DensityPRO Specific Parameters

ALARMG.

Parameter Type | R/W | Description
ALARM5S ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for
ALARMS.
Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =0utput 1 to FAULT LOW
1 = Control relay 1 5= Output 1 to FAULT HIGH
2 = Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
ALARM6 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for

Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =0utput 1 to FAULT LOW
1 = Control relay 1 5= Output 1 to FAULT HIGH
2 = Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
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Parameter Type | R/W | Description
ALARM?7 ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for
ALARM?7.
Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =QOutput 1 to FAULT LOW
1 = Control relay 1 5= 0utput 1 to FAULT HIGH
2 =Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_POINT_ Enter clear point or dead band value.
DEADBAND
ALARMS ALM | R/W | Set up alarm triggering point, clear point, and gauge actions when alarm happens for
ALARMS.
Sub-parameter | Description
ACTION Select the action used to indicate that the alarm has been
triggered.
0 = Nothing 3 =Qutput 1 to FAULT LOW
1= Control relay 1 5=0utput 1 to FAULT HIGH
2 = Control relay 2
SET_POINT The process level at which the alarm will activate
CLR_MODE Select a clear point (clr point) or dead band (deadband) to clear
the alarm.
0 =clr point 1 = deadband
CLR_PQINT_ Enter clear point or dead band value.
DEADBAND
BAD_FLAGS_1 BF R Bad flags set 1
Bit 0 - "Bad entry values see details Bit 16 - "Invalid Density Slope"
in setup”
Bit 1 - "No bad data detected" Bit 17 - "Unit has not been standardized"
Bit 2 - "No Bad Entries" Bit 18 - "Flow/Temp use same A/D Chan"
Bit 3 - "Solution Polynomial failed" Bit 19 - "Unit address > 32"
Bit 4 - "Meas 1 is not Density" Bit 20 - "Unused"

Bit 5 - "Meas # Select code includes Bit 21 - "Unused"

flow"

Bit 6 - “Cal den value is not realistic” | Bit 22 - “Number of Break Points > 16"

Thermo Fisher Scientific
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DensityPRO Specific Parameters

Parameter Type | R/W | Description
BAD_FLAGS_1 (cont.) BF R Bad flags set 1
Bit 7 - “1 Cal-Std ratio value too Bit 23 - “Data Testing suspended”
low”
Bit 8 - “1 Cal-Std ratio too high” Bit 24 - "Max flow required but not entered”
Bit 9 - “Pipe ID value too low" Bit 25 - “Unused”
Bit 10 - "Standardization detector | Bit 26 - “Unused”
count too low”
Bit 11 - "Cal value too low” Bit 27 - "Unused”
Bit 12 - "2 Cal-Std ratio value too | Bit 28 - “Unused”
low”
Bit 13 - "2 Cal-Std ratio value too | Bit 29 - "Window Code must be greater than
hi” 0"
Bit 14 - “Invalid STD mode” Bit 30 - “Transmit update time must be >
19"
Bit 15 - “Invalid Days/week” Bit 31 - “Master Unit has no update time”
BAD_FLAGS_2 BF R Bad flags set 2
Bit 0 - "Unused” Bit 5 - “Brktab Range Error”
Bit 1 - "Unused” Bit 6 - "Div. by 0 Errin”
Bit 2 - "No Rate Channel
specified” Bit 7 - “ Xray Safeguard Min Hold is > Max”
Bit 3 - “Measurement # for rate Bits 8 through Bit 31 - “Unused”
must BE< 1"
Bit 4 - "PIPE ID null”
CAL_STD_RATIO_FROM_ CAL | R/W | The calibration/standardization ratio from latest calibration.
LAST_CAL
CAL_X_TIME_CONST CON | R/W | Specify the number of time constant periods to be used for the calibration cycle.
CAL1_TEMP CAL | R/W | Temperature of CAL point 1 (normally learned during calibration).
CAL2_TEMP CAL | R/W | Temperature of CAL point 2 (normally learned during calibration).
CARRIER_ATTEN_COEF CAL | R/W | The carrier attenuation coefficient used to calculate density based on the detector
signal.
CARRIER_GRAVITY CON | R/W | The gravity of the carrier in the process material.
CARRIER_TEMP_COMP_ CON | R/W | The carrier temperature compensation polynomial.
POLY 0 = User defined 1=H20, <90 C, REF 20
CARRIER_TEMP_EQ_COEFA | CON | R/W | Carrier temperature compensation equation coefficient A.
CARRIER_TEMP_EQ_COEFB | CON | R/W | Carrier temperature compensation equation coefficient B.
CARRIER_TEMP_EQ_COEFC | CON | R/W | Carrier temperature compensation equation coefficient C.
COUNTDOWN_TIMER S R The time left in seconds to complete standardization or calibration.
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Parameter Type | R/W | Description
DATA_REF_CNT_RATIO S R The data/ref count ratio.
DAYS_GAUGE_ON CON | R/W | The number of days the gauge is on in one week.
DENSITY_CAL_POINT1 CAL | R/W | The density at calibration point 1.
DENSITY_HOLD_MODE CON | R/W | The hold value for the density measurement.
DENSITY_SLOPE CAL | R/W | Density slope.
DETECT_SIG_VALUE S R The internal value of the detector signal.
DPRO_CMD CMD | R/W | Commands that can be issued to the DensityPRO.
Ready Select alternate time constant
Hold current output Select primary time constant
Clear all alarms Erase all entries (EVERYTHING)
Start CAL cycle Restart
Hold current output at maximum Erase all alarm action assignments
setting
Hold current output at minimum Hold current output at FAULT LOW
setting
Clear ALL holds Start Standardization
Hold density at density hold mode Switch current out to alt/pri mode
value
Hold current output at FAULT HIGH Abort standardization
Start system test Erase protected NVRAM
Use latest CAL value for CAL point 1 Refresh
DRY_BULK_DENSITY_FOR_ | CON | R/W | The dry bulk density for flow measurement (shown if bulk solids flow selected for
FLOW_MEAS MEA1_READ, MEA2_READ, MEA3_READ, or MEA4_READ.
FLOW_VOLUME_UNIT CON | R/W | The volume units for the flow measurement.
2 = cubic meter 6 =gallon
4 = cubic feet 10 = liter
5 = cubic yard
HEAD_TYPE CON | R/W | The source head type.
1'=5190 source head 5=5201 source head
2 =5191 source head 6 = 5202 source head
3 =5176 source head 7 =5203 or 5204 source head
4 =5200 source head 8=5211 source head
HV_CTL S R The high voltage control signal.
IOUT_HOLD_VALUE CON | R/W | The current output hold value.
I0UT_MAX_CORRECTION CON | R/W | The correction factor for the current output at maximum.

Thermo Fisher Scientific
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Parameter Type | R/W | Description
I0UT_MIN_CORRECTION CON | R/W | The correction factor for the current output at minimum.
I0UT1_VALUE S R The internal value of IOUT1.
I0UT1_VALUE_PERCENT S R The internal value of IOUT1 in percent.
LAST_STD S R The status of the last standardization cycle.
1 =full of carrier 6 = full of process
2 =empty
LUMP_STATUS S R The lump status.
MASS_FLOW_TIME_UNIT CON | R/W | The time units for the mass flow measurement.
2 = minutes 3 =hours
MASS_FLOW_UNIT CON | R/W | The mass units for the mass flow measurement.
4 = metric ton 5 = short ton
MATERIAL_TYPE CON | R/W | The material type that most closely matches the process material.
1 =slurry 3 =single phase
2 = solution 4 = emulsion
MAX_IOUT_VALUE CON | R/W | The maximum current output in mA (4.0 to 20.5 mA).
MEA_NUM_ALARM1_ CON | R/W | The measurement number ALARM1 is assigned to.
ASSIGN
MEA_NUM_ALARM2_ CON | R/W | The measurement number ALARM?Z is assigned to.
ASSIGN
MEA_NUM_ALARMS3_ CON | R/W | The measurement number ALARM3 is assigned to.
ASSIGN
MEA_NUM_ALARMA4_ CON | R/W | The measurement number ALARM4 is assigned to.
ASSIGN
MEA_NUM_ALARMS5_ CON | R/W | The measurement number ALARMS is assigned to.
ASSIGN
MEA_NUM_ALARM6_ CON | R/W | The measurement number ALARMG is assigned to.
ASSIGN
MEA_NUM_ALARM7_ CON | R/W | The measurement number ALARM?7 is assigned to.
ASSIGN
MEA_NUM_ALARMS_ CON | R/W | The measurement number ALARMS is assigned to.
ASSIGN
MEA_NUM_AT_CURRENT_ CON | R/W | The measurement sent to the current output in alternate mode.
OUT_ALTMODE
MEA_NUM_AT_CURRENT_ | CON | R/W | The measurement sent to the current output in normal mode.

OUT_PRIMODE

DensityPRO with FounDATION™ fieldbus Application Guide
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Parameter Type | R/W | Description
MEA1_READ CON | R/W | The measurement type for measurement 1.
If the material type is slurry:
1 =density 6 = % by weight solids
3 = solids content/vol 7 =% by weight carrier
4 = carrier content/vol 8 = % by volume solids
5 = solids/carrier 9 =% by volume carrier
If the material type is solution:
1 =density 6 = % by weight solute
2 = bulk density 7 =% by weight solvent
3 = solute content/vol 8 = % by volume solute
4 = solvent content/vol 9 = % by volume solvent
5 = solute/solvent
If the material type is single phase:
1 = density
If the material type is emulsion:
1 = density 6 = % by weight fluid_2
3 =fluid_2 content/vol 7 =% by weight fluid_1
4 =fluid_1 content/vol 8 = % by volume fluid_2
5 = fluid_2/fluid_1 9 = % by volume fluid_1
MEA1_READOUT S R The value of measurement 1.
MEA1_UNIT CON | R/W | The density units for measurement 1.
If PRIMARY_MEASURE_TYPE is 1, 2, 3,4, or 5:
1=g/mL 8=o0z/cuin
2 = Ib/gal 9=Ib/cuin
3 =1Ib/UK gal 10=g/cuin
4 =1Ib/cu ft 11 =Ib/cu yd
5 =ston/cu yd 13 = degAPI
6 = Iton/cu yd 14 = degBaum It
7=g/l 15 = degBaum hv
If PRIMARY_MEASURE_TYPE is 6,7, 8, or 9:
Show %
MEA2_READ CON | R/W | The measurement type for measurement 2.
0 = inactive 20 = temperature (deg F)
19 = temperature (deg C)
MEA2_READOUT S R The value of measurement 2.

Thermo Fisher Scientific
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Parameter Type | R/W | Description
MEA3_READ CON | R/W | The measurement type for measurement 3.
If the material type is slurry:
0 = inactive 14 = solids volume flow
13 = bulk volume flow 15 = carrier volume flow
If the material type is solution:
0 = inactive 14 = solute volume flow
13 = bulk volume flow 15 = solvent volume flow
If the material type is single phase:
0 = inactive 13 = bulk volume flow
If the material type is emulsion:
0 =inactive 14 = fluid_2 volume flow
13 = bulk volume flow 15 = fluid_1 volume flow
MEA3_READOUT S R The value of measurement 3.
MEA4_READ CON | R/W | The measurement type for measurement 4.
If the material type is slurry:
0 = inactive 12 = carrier mass flow
10 = bulk mass flow 16 = bulk solids flow
11 = solids mass flow
If the material type is solution:
0 =inactive 12 = solvent mass flow
10 = bulk mass flow 16 = bulk solute flow
11 = solute mass flow
If the material type is single phase:
0 = inactive 10 = bulk mass flow
If the material type is emulsion:
0 = inactive 11 = fluid_2 mass flow
10 = bulk mass flow 12 =fluid_1 mass flow
MEA4_READOUT S R The value of measurement 4.
MEASURE1_AT_MAX_IOUT | CON | R/W | The measurement 1 value that represents the maximum current output.
MEASURE1_AT_MIN_IOUT CON | R/W | The measurement 1 value that represents the minimum current output.
MEASURE2_AT_MAX_IOUT | CON | R/W | The measurement 2 value that represents the maximum current output.
MEASURE2_AT_MIN_IOUT CON | R/W | The measurement 2 value that represents the minimum current output.
MEASURE3_AT_MAX_IOUT | CON | R/W | The measurement 3 value that represents the maximum current output.
MEASURE3_AT_MIN_IOUT CON | R/W | The measurement 3 value that represents the minimum current output.
MEASURE4_AT_MAX_IOUT | CON | R/W | The measurement 4 value that represents the maximum current output.

DensityPRO with FounDATION™ fieldbus Application Guide

Thermo Fisher Scientific




DensityPRO Specific Parameters

Parameter Type | R/W | Description
MEASURE4_AT_MIN_IOUT CON | R/W | The measurement 4 value that represents the minimum current output.
MIN_IOUT_VALUE CON | R/W | The minimum current output in mA (3.80 to 20.0 mA)
NUM_MEASUREMENT S R The number of active measurements.
NUMBER_OF_RELAYS S R The number of relays available.
PIPE_INSIDE_DIAMETER CON | R/W | The inside diameter of the process pipe.
PRIMARY_MEASURE_TYPE | CON | R/W | The primary measurement type.
If the material type is slurry:
1 = density 6 = % by weight solids
3 = solids content/vol 7 =% by weight carrier
4 = carrier content/vol 8 = % by volume solids
5 =solids/carrier 9 =% by volume carrier
If the material type is solution:
1 = density 6 = % by weight solute
2 = bulk density 7 =% by weight solvent
3 = solute content/vol 8 = % by volume solute
4 = solvent content/vol 9= % by volume solvent
5 = solute/solvent
If the material type is single phase:
1 = density
If the material type is emulsion:
1 =density 6 = % by weight fluid_2
3 =fluid_2 content/vol 7 =% by weight fluid_1
4 =fluid_1 content/vol 8 = % by volume fluid_2
5 = fluid_2/fluid_1 9 =% by volume fluid_1
PROCESS_TEMP_LEARNED_ | CAL | R/W | The process temperature learned during the calibration cycle.
AT_CAL
REFERENCE_DENSITY CON | R/W | The material density at the reference temperature.
REFERENCE_TEMPERATURE | CON | R/W | The temperature used by the gauge for temperature compensation calculations.
RELAY1_ALM_MODE CON | R/W | The alarm mode for relay 1.
0 = energize when alarm occurs 1 = deenergize when alarm occurs
RELAY1_LATCH_MODE CON | R/W | The latching mode for relay 1.
0 = disable latching mode 1 = enable latching mode
RELAY2_ALM_MODE CON | R/W | The alarm mode for relay 2.
0 = energize when alarm occurs 1 = deenergize when alarm occurs
RELAY2_LATCH_MODE CON | R/W | The latching mode for relay 2.

0 = disable latching mode 1 = enable latching mode

Thermo Fisher Scientific
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Parameter Type | R/W | Description
SIZE_UNIT CON | R/W | The units used to specify the pipe ID.
T=cm 4 =ft
2=mm 5=yd
3=in 6=m
SOLID_ATTEN_COEF CAL | R/W | The solids attenuation coefficient used to calculate the density based on the detector
signal.
SOLID_GRAVITY CON | R/W | The gravity of the solids in the process material.
SOLID_TEMP_COMP_POLY | CON | R/W | The solids temperature compensation polynomial.

If the material type is solution:

0 = user defined 3 =sugar, at 50%
1 =sugar, at 10% 4 =sugar, at 75%
2 = sugar, at 25%

If the material type is slurry, single phase, or emulsion:
0,1,2,3,4=user defined

SOLID_TEMP_EQ_COEFA CON | R/W | Solids temperature compensation equation coefficient A.
SOLID_TEMP_EQ_COEFB CON | R/W | Solids temperature compensation equation coefficient B.
SOLID_TEMP_EQ_COEFC CON | R/W | Solids temperature compensation equation coefficient C.
SOLUTION_POLY_COEFA CON | R/W | Solution polynomial coefficient A.
SOLUTION_POLY_COEFB CON | R/W | Solution polynomial coefficient B.
SOLUTION_POLY_COEFC CON | R/W | Solution polynomial coefficient C.
SOLUTION_POLY_COEFD CON | R/W | Solution polynomial coefficient D.

SOLUTION_POLY_TYPE CON | R/W | The polynomial formula used to relate the solution’s density to its concentration.
1= Suc 0-100% 7=KOH 0-52%
2 = D-Fruc 0-60% 8 = HCl 0-40%
3 =D-Gluc 0-10% 9 =H3P03 0-40%
4 =NaCl 0-50% 10 = A-Lac 0-18%
5=NaOH 0-50% 11 =H-Lac 0-18%
6 = KCl 0-24% 13 = User entered polynom
SOURCE_HALF_LIFE_VALUE | CON | R/W | The source half-life in years.
STD_IN_USE_VALUE S R The standardization value currently in use.
STD_ON_PIPE_COND CON | R/W | The condition of the pipe during standardization.
0=none 2 =empty
1 =full of carrier 6 = full of process
STD_VALUE CON | R/W | The standardization value from the last cycle.
STD_X_TIME_CONST CON | R/W | The number of time constant periods used for the standardization cycle.
TC_ALTERNATE CON | R/W | The alternate time constant.
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Parameter Type | R/W | Description
TC_PRIMARY CON | R/W | The primary time constant.
TEMP_CONSTANT CON | R/W | The temperature constant in deg C.
TEMP_INPUT_SOURCE CON | R/W | The source of the temperature input signal.
0 =not used 2 =Manual entry

1 =100-ohm American RTD

TEMP_OFFSET_CORRECTIO | CON | R/W
N The temperature offset correction in deg C.

USE_TEMP_COMP_ON_STD | CON | R/W | Select whether temperature compensation equation will be used on the
standardization cycle.

0=no 1=yes

VOLUME_FLOW_TIME_UNIT | CON | R/W | The time units assigned to the volume flow measurement.

2 =minutes 3 =hours
WKS_SINCE_LAST_STD CON | R/W | The number of weeks since the last standardization.
XRAY_MAX_HOLD_TIME CON | R/W | The xray safeguard maximum hold time in seconds.
XRAY_MIN_HOLD_TIME CON | R/W | The xray safeguard minimum hold time in seconds.
XRAY_MODE CON | R/W | The xray safeguard mode.

0 = disable xray safeguard 1 = enable xray safeguard
XRAY_THRESHOLD CON | R/W | The xray safeguard threshold.
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Appendix D
DensityPRO Commands

Note If you are not using the NI-FBUS Configurator, reference the
documentation that came with your host system. A

In the NI-FBUS Configurator, open the AI_TRANSDUCER block, and
click the Others tab. Click on DPRO_CMD to view the list of available
commands. To execute a command, select it from the drop-down list, and

Thermo Fisher Scientific

click Write Changes.
- o]
[8)_TRANSDUCER HEaE dss nmne
W PeiodicUpdates  [2(sec] =]
005 |[Awo
Piocess | 1/0 Corfig | Alams | Diagnostics | Trends Others | Mathods |
Pasametes Value Type &
L TRANSDUCER_DIRECTORY m
B @ COLLECTION DIRECTORY
COLLECTIOMN_DIRECTORY 3]
ach -] T
;
@ COUNTDOWN_TIMER Hold cunent cutput a0
Clear all alar
@ LEVEL_AT_MIN_IOUT Start CAL CEL ~d
Held curtent at max
@ LEVEL_AT_M&X_I0UT Fiekd comact ot min o
Clear ALL Hold
@ MIN_IOUT_VALUE Systemtest R
Lise Atemate Time Const
@ MAX_IDUT_VALUE Dse Pinary Time Condt. R
A calbration table
@ IOUT_MIN_CORRECTION | avoq ontbrtn vt
Erase all enines [EVERYTHING
@ OUT_MAX_CORRECTION  |Rny T ¢ ! @
Start Standardization
< ABORT Stardardization L
Wiite Changes E?;;ruwed MM

Figure D-1. Drop-down list for the DPRO_CMD parameter

Descriptions of the commands are provided in the following table.
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DensityPRO Commands

Table D-1. DensityPRO commands

Command

Description

Ready

The interface is ready for the next command.

Hold current output

Hold the current output at the current output hold
value.

Clear all alarms

Acknowledges, clear, and reset all alarms.

Start CAL cycle

Begin a calibration cycle.

Hold current output at maximum
setting

Hold the current output at the maximum output value.

Hold current output at minimum
setting

Hold the current output at the minimum output value.

Clear ALL holds

Clear all holds that are currently active.

Hold density at density hold mode
value

Hold the density at the density hold mode value.

Hold current output at FAULT HIGH

Hold the current output at the FAULT HIGH level.

Start system test

Causes the unit to test the various types of memory,
the data integrity, and the signal processor. The system
performs an automatic test and verification function
every 10 minutes, and all user-entered data is double
stored and periodically cross-checked. Errors are
automatically corrected, and an alarm is activated
when an error is detected.

Use latest CAL value for CAL point
1

Use the latest CAL value as CAL point 1.

Select alternate time constant

Switch to the alternate time constant
(TC_ALTERNATE).

Select primary time constant

Switch to the primary time constant (TC_PRIMARY).

Erase all entries (EVERYTHING)

Erase all configured data.

Restart without power cycling

Restart the system without cycling power.

Erase all alarm action assignments

Erase entries for alarm assignments to relays, current
output, etc.

Start standardization

Begin a standardization cycle.

Hold current output at FAULT LOW

Hold the current output at the FAULT LOW level.

Switch current out to alt/pri mode

Switch the current output to alternate/primary mode.

Abort standardization

Stop the currently running standardization cycle.

Erase protected NVRAM

Erase NVRAM.

Refresh

Refresh the data in the fieldbus interface.
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Appendix E

DD Flow Blocks

The DensityPRO with FOUNDATION fieldbus DD is designed to offer
access to the gauge’s process data and basic setup functions. The DD menu

flow blocks are provided in this appendix.

Note Text in blue indicates user entered data or selections. A

Root Menu

h 4

hJ

L

hJ

hJ

1 Setup

~
i

Standardization

3 Calibration

4 Alarm

#

Lctions

I

5.

G Diag/senice

Figure E-1. Root menu

Root Menu
1 Setup
! ; I ' '
1 Density Setup 2 Time Constant 3 Temp. 4 Other meas 5 View other meas
Compensation assign & modify
setup

Figure E-2. Setup menu
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DD Flow Blocks

Root Menu |—>| 1 Setup I—D| 1 Density Setup I—Dl Density Setup |
|

+
Source Head Geamet i
WARNING — This function 1=5190 5=5201 ¥ i :f\g?;?rr\;al Tipe
can affect device output. | | 2-5191 §=5202 Ll 2 aiitinn
Loop should be removed 3=5176 7 =5203/5204 3= Single phase
from automatic control. 4=5200 8=5211 A= Eilsioh
I
! IE E b
Carrier Gravity Solvent Gravity Primary Fluid1 Gravity
X.XX XXX Measurement XXX
Solids Gravity v 1 Density Fluid2 Gravity
X.XX Salution Type 2 Bulk Density XXX
v 1 Suc 0-100% i
Primary e Solution Palynomial Pri
Measurement Sfelt Y A- Coeffitient PP
1 Density  Nabi -80% XXX D egsurement
: 5 NaOH 0-50% 13 2o ‘ 15 1 ensity
3 Solids content/vol 6 KCl 0-24% Solution Polynomial 3 Fluid2 content/vol
4 Carrier content/vol 7 KOH 0-52% B - Coefficient 4 Fluid 1 content/vol
v - (2]
5 Solids/carrier 8 HCI 0-40% X XXX 5 Fluid2/Fluid1
6 %by weight solids 9 H3PO3 0-40% Solution Polynomial 6 % by weight Fluid2
7 % by weight carrier 10 A-Lac 0-18% C - Coefficient 7 % by weight Fluid1
i {o]
8 O/ob‘{ volume solids 11 H-Lac 0-18% X KXX 8% bV volume Fluid?
9 % bv volume carrier {81 hersniemd il Solution Polynomial 9% by volume Fluid1
6-0 1-5 D - Coefficient
* 1-11 XXX 6-9
Temp. Input Source
0 Not used
1 100-ohm American RTD |~
2 Manual entry
v
Primary Measurement
1 Density 3
2 Bulk Density Density unit
3 Solute content/vol 1 g/ml 8 oz/cu in
4 Solvent content/vol 2Ib/US gal 9 Ib/euin
5 Solute/Solvent 15 | 3Ib/UKgal  10g/cuin
6 % by weight Solute A 7| 4bfeuft 11 Ib/cuyd
7 % by weight Solvent Sston/cuyd 13 deg API
8 % by volume Solute 6 Iton/cuyd 14 deg Baum It
9 % by volume Solvent 79/l 15 deg Baum hv
24 Pt Level
25 Glass Level
b6-75
T
Y
Structural Unit
p| TcCm 41t ¢
2mm  5vyd
3in Bm
L ] . -
Pipe Inside Diameter Meas #1 Reading Meas #1 Reading NOTE - Loop may
e = for20mA Qutput [ for4mA Qutput [ be returned to
- X XXX X.XXX automatic contral.

Figure E-3. Density setup
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DD Flow Blocks

Root Menu > 1 Setup —» 2 Time Constant »  Time constant setup
WARNING — This
fU”F“U” can affect Primary Time Constant Alternate Time Constant Current Time Constant
device output. Loop ! Value - Value » 1 Primary TC
should be removed fram X 2 Alternate TC
automatic control.
v
NOTE - Loop may be
returned to

Figure E-4. Time constant setup
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automatic contraol.
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DD Flow Blocks

3 Temp. Temperature Comp.
— ! |
Raot Menu I_' 1 Setvp Compensation Setup
|
h 2
WARNING — This function Temperature Input Source
can affect device output. 0 Not used 2 | Temp hold constant
Loop should be remaved 1 100-ohm American RTD XXX
from automatic contral. 2 Manual entry
0-1
Read Material Type
1 Slurry
2 Solution <
3 Single phase
4 Emulsion
[
v y? 13 Iz
Carrier temp comp Solvent temp comp Fid temp comp polynomial Fluid1 temp comp
polynomial {eq 1) polynomial {eq 1) leq 1) polynomial (eq 1)
0 User defined 0 User defined 0 User defined 0 User defined
1 H20, <90 C, REF 20 1 H20, <80 C, REF 20 1 H20, <90 C, REF 20 1 H20, <90 C, REF 20
A 4 v A 4 y
Solid temp comp polynomial Solute temp comp Product temp comp Fluid2 temp comp
(eq 2) polynomial (eq 2) polynomial (eq 2) polynomial (eq 2)
0 User defined 0 User defined 0 User defined 0 User defined
1 Sugar at 10%
2 Sugar at 25%
3 Sugar at 50%
4 Sugar at 75%
A 4
Ref. Temperature | v v
XXX B
Ref. Density for Carrier temp Temp comp equation Temp comp equation
solid temp paly comp poly (eq1) (eq 1) Coefficient A | (eq 1) Coefficient B
XXX K. XX K.XX
|
v :
Temp comp equation Enable/Disable temp
(eq 1) Coefficient C | comp (eq 1)
Sae 1 Do not use EQ1
i Z use
&
Temp comp equation Temp comp equation Temp comp equation Temperature error NOTE - Loop may be
(eq 2) Coefficient A [ (eq?2)CoefficientB 1 (eq 2) Coefficient G |- correction B returned to automatic
XXX XXX XXX XXX control.

Figure E-5. Temperature compensation setup
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DD Flow Blocks

Root KMenu

> 1 Setup

4 Other meas assign
> .
& modify

Other meas assign
& modify

h J

WARNIMG — This function
can affect device output.
Loop should be removed
from autornatic control.

select following
Measurement to configure:
1 measurement #2
? measurement #3
3 measurement #4

1

¥

]

Y

K]
Y

Reading represented by
measurement #2 is
0 inactive
19 temperature (deq C)
20 temperature (deg F)

Figure E-6. Other meas assign & modify
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Reading represented by
measurement #£3 is
0 inactive
13 Bulk volume flow
14 Solids volume flow
15 Carrier volume flow

'

Unit selection:
2 cubic meter
4 cubic feet
5 cubic vard
G gallon
10 liter

measurement #4 is
0 inactive
10 bulk mass flow
11 solute mass flow
2 solvent mass flow
16 bulk solute flow

Reading represented by

h 4

Unit selection:
4 metric ton
5 short ton

r 3

Y

Time Unit selection;
minutes
ours

2
31
J

>
-
y

lWeas reading for

High end value:

XXX

eas reading for
Low end value:

h 4

MOTE - Loop may be
returmed to
X KXX automatic contral.
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DD Flow Blocks

v View other
Root Menu > 1 Setup »  HView other meas >
l ) - measurement
v
WARNING — This select following Meas #x s
function can affect Measurement to view: HXKNK o | NOTE - Loop may be
device output. Loap * 1 measurement #2 # Value: xxex » retumed to
should be removed from 2 measurement #3 1 Select Other Meas autormatic contral,
autormatic contral. 3 measurement #4 2 Exit
F 3
1
Figure E-7. View other meas
WARNING — This function
Root Menu —» 2 Standardization »  Standardization p Al affect device output
Loop should be removed
from automatic contral.
¥ standardization on
STD Cvele time 0 Maone 1 start Data Cycle | Standardization Oata Cycle
(# of x sec ime constantl: 1 full of carmer —5—> 1 7Ves > Time Remaining: s
. 2 empty 2 Nao Click Mext to update Timer
6 full of Process i
i K=
P x =1
¥y
CAL Density Value
h J b J
MOTE - Loop may be standardization
retumed to < Data Cycle has been
automatic contral. completed

Figure E-8. Standardization
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DD Flow Blocks

WARNING — This function
can affect device output.
Loop should be removed
from automatic control.

Root Menu —»{ 3 Gauge Calibration Calibration —

v

. , Temperature Input Source
Cal Cycle time CAL Density value 0 Nnﬁ o e 1. | Process temperature
(#of x se; time —P XXX ™ 1 100-0hm American RTD »{ learned during CAL
constant): x 2 Manual entry XX.XX
0
y Y
Start calibration cycle CAL #1 Temperature
; 1 Exit < CAL
Z Start cycle XX XX
1
A 4
Use Latest CAL Value _‘
for CAL point 1: Attenuation Coef of
1 Skip »| Carrier
2 Execute XN
Gauge Calibration Cycle Attenuation Coef of
Time Remaining: xxs Solid
Click Next to update XXXX
xx=0 * xx>0 ¢
Y STD mode @ CAL
latest
KXKX
¢ y
Use Latest CAL Value NOTE '[lj'oop fhiayoa
for CAL point 1: IR
1 Skip automatic control.
2 Execute

Figure E-9. Calibration
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DD Flow Blocks

WARMIMNG — This function
can affect device output.
Loop should be removed
from automatic contral.

L J

Alarm Setup

L J

Root Menu > 4 Alarm

i

select alarm Inunjher Alarm set point Alarm clear mode | Alarm clear point
to setup (1-8) o I —m 1 Clear Point —" e
X 2 Deadband
? l
Alarm Set Action
i Mathing
Alarm Deadband | 1 Control relay 1
HXHX 2 Contral relay 2
3 Output 1 to FALLT LOWVY
5 Cutput 1 to FALLT HIGH

l

MOTE - Loop may be
returned fo
automatic contral.

Figure E-10. Alarm setup

WARMNING — This function
can affect device output,
Loop should be removed
from automatic contral.

,

Root [Menu 5 Actions —® 1 Systemorestart

4

MWOTE - Loop may be
retumed to automatic
contral.

Figure E-11. System restart
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DD Flow Blocks

5 Actions

'

Root Menu

? Erasze all entries

Figure E-12. Erase all entries

VA
YA

RMNIMNG — This function
can affect device output.
Loop should be removed
fram automatic contral.

;

MNOTE - Loop may be
returmned to automatic

WARNING — This function
Root Menu — b Actions | »  3Clearall alarms  |—»| o0 affect device output
Laop should be removed
fram automatic contral.
\ 4
MOTE - Loop may be
returned to automatic
Figure E-13. Clear all alarms
Root lenu
G Diag/Service
v v v . 4 ) 4
1 Current Output 2 Loop Test 3 Trim Analog 4 Device Status 5 Al Transducer
Output Parameters

Figure E-14. Diag/Service menu
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DD Flow Blocks

Roat Menu —» 6 Diag/service i 1 Current Output —»  Current output setup

v

WARMING — This function can
affect device output. Loop
should be removed from
automatic control.

Waximum current output

B

Minirurm current output

B

Measurement number
used for current output

Figure E-15. Current output setup
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Current output hold mode
value (% of scale)

v
MOTE - Loop may be
returned to

automatic contral.
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Root Menu

v

6 Diag/Service

v

7 Loop Test

v

Loop test

v

WARNING — This function
can affect device output.
Loop should be removed
from automatic control.

1 4mA
2 20mA

v

Choose analog
output level

DD Flow Blocks

3 Other
4 End
v v? v?o
Fld device output Fld device output Output
is fixed at 4 mA is fixed at 20 mA XXX
1 Yes 1Yes
2 No 2 No
1 1 )
Field device output is
A e A4 4R fixed at xx.xx percent

Figure E-16. Loop test

1 Yes
2 No

A

-
%

h 4

Returning field
device to original
output

h 4

NOTE - Loop may be
returned to
automatic control.
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DD Flow Blocks

Root Menu — 6 Diag/service —» 3 Trim Analog Output - Trim analog output

4
WARNIMNG — This function
can affect device output.
Loop should be removed
from automatic contraol.

'

. . " oo XK _l"
Connect Setting output Output is set at x.xx mA Does ‘l‘Et DL:tlet'l' . m:«
ey equal readout device?
reference meter  —#  to minimum Enter meter value — Ly IHal Tez
Vo
current value XXX res
2 No

L]

Does set output xxxx mA . j _
o | A Output is set at xxxx mA setting output
equal readout device? _ .
| Ves - Enter meter value ———  to maximum
L KX, XK current value
2 No

i 1

Returning device to
ariginal output

'

MOTE - Loop may be
returned to
automatic contral.

Figure E-17. Trim analog output

Y

Device status

Root Wenu }—b G Diag/Senice —» 4 Device Status

v All Status see all flags again? | IMethod execution
Holdis) are active | Keypad in use —» information has  —»{ 1Yes —» has cormpleted
A been displayed ? No

Mote; The Device Status allowes a user to viewe which device status, fault, and alarm bits are set. The above is only an example.

Figure E-18. Device status
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Root Menu
v
6 Diag/Service
v

5 Al Transducer
Parameters

]

DD Flow Blocks

DPRO_CMD
COUNTDOWN_TIMER
TC_PRIMARY

STD_VALUE
DETECT_SIG_VALUE
DENSITY_CAL_POINT
CARRIER_ATTEN_COEF
SOLID_ATTEN_COEF
HV_CTL
DATA_REF_CNT_RATIO
WKS_SINCE_LAST_STD
HEAD_TYPE
MATERIAL_TYPE
CARRIER_GRAVITY
SOLID_GRAVITY
TEMP_INPUT_SOURCE
TEMP_CONSTANT
CARRIER_TEMP_COMP_POLY
|| REFERENCE_TEMPERATURE
CARRIER_TEMP_EQ_COEFA
CARRIER_TEMP_FQ_COEFB
CARRIER_TEMP_EQ_COFFC
USE_TEMP_COMP_ON_STD
SOLID_TEMP_EQ_COFFA
SOLID_TEMP_EQ_COFFB
SOLID_TEMP_EQ_COEFC
REFERENCE_DENSITY
SOLUTION_POLY_TYPE
SOLUTION_POLY_COEFA
SOLUTION_POLY_COEFB
SOLUTION_POLY_COEFC
SOLUTION_POLY_COEFD
TEMP_OFFSET_CORRECTION
PRIMARY_MEASURE_TYPE
MEAT_UNIT

MEAZ_UNIT

MEA3_UNIT

MEA4_UNIT
SIZE_UNIT

PIPE_INSIDE_DIAMETER
MEASURET_AT_MIN_IOUT
MEASURET_AT_MAX_IOUT
MEASURE2_AT_MIN_IOUT
MEASURE2_AT_MAX_IOUT
MEASURE3_AT_MIN_IOUT
MEASURE3_AT_MAX_IOUT
MEASURE4_AT_MIN_IOUT
MEASURE4_AT_MAX_IOUT
MIN_IOUT_VALUE
MAX_IOUT_VALUE
I0UT_MIN_CORRECTION
I0UT_MAX_CORRECTION
I0UT_HOLD_VALUE
TC_ALTERNATIVE
SOURCE_HALF_LIFE_VALUE
CAL_X_TIME_CONST
STD_X_TIME_CONST
STD_IN_USE_VALUE
DAYS_GAUGE_ON

CALT_TEMP
CAL_STD_RATIO_FROM_LAST_CAL
PROCESS_TEMP_LFARNED_AT_CAL
LAST_STD

NUM_MEASUREMENT
MEAT_READ

MEA2_READ

MEA3_READ

MEA4_READ

MEAT_READOUT

MEA2_READOUT

MEA3_READOUT

MEA4_READOUT
MEA_NUM_AT_CURRENT_OUT_PRIMODE
MEA_NUM_AT_CURRENT_OUT_ALTMODE

I0UT1_VALUE_PERCENT
LUMPT_STATUS

XRAY_THRESHOLD
XRAY_MIN_HOLD_TIME
XRAY_MAX_HOLD_TIME
XRAY_MODE

ALARM

ALARM?

ALARMS3

ALARM4

ALARMS

ALARMS

ALARM7

ALARMS
ALARMT_MONITOR_MEAS_ASSIGN
ALARM2_MONITOR_MEAS_ASSIGN
ALARM3_MONITOR_MEAS_ASSIGN
ALARMA4_MONITOR_MEAS_ASSIGN
ALARMS5_MONITOR_MEAS_ASSIGN
ALARMB_MONITOR_MEAS_ASSIGN
ALARM7_MONITOR_MEAS_ASSIGN
ALARMS_MONITOR_MEAS_ASSIGN
RELAY1_ALM_MODE
RELAY1_LATCH_MODE
RELAYZ_ALM_MODE
RELAYZ_LATCH_MODE
NUMBER_OF_RELAYS

I0UT1_VALUE
DENSITY_HOLD_MODE
FLOW_VOLUME_UNIT
VOLUME_FLOW_TIME_UNIT
MASS_FLOW_UNIT
MASS_FLOW_TIME_UNIT

Figure E-19. Al_Transducer Parameters
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Glossary

analog input block Makes manufacturer's input
data available to other functions at its output.

AUTO See automatic mode.

automatic mode (AUTO) The normal operating
mode of a block.

basic device Device type that communicates on the
fieldbus network. It cannot become the LAS.

bridge Device type that connects two or more
devices on the fieldbus network.

DD See device description.

device description (DD) A machine-readable
description of all the blocks and block parameters
of a device.

device ID The unique identifier assigned to the
device by the manufacturer.

device tag The unique name assigned to the device
by the user.

FounDATION fieldbus The communications
network specification created by the Fieldbus
Foundation.

LAS See link active scheduler.
link active scheduler (LAS) The device that is

currently controlling access to the fieldbus.

link master Controls communications traffic on a
link and prevents multiple devices from
communicating data at the same time.

MAN See manual mode.

manual mode (MAN) In this mode, the block
output is set by the user through the interface
device.

node address The device address.

Thermo Fisher Scientific

0OO0S See Out Of Service mode.

out of service mode (OOS) The mode typically
used during block configuration. In OOS mode,
the block is disabled.

PD tag The physical name of the device.

resource block Contains device information, such as
the device tag and device ID.

transducer block Allows a user to configure or view
setup parameters and access system diagnostic
tools.

DensityPRO with FOUNDATION™ fieldbus Application Guide GLOSSARY-1
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Index

4
4-20 mA current output, 1-3

specification, B-2

A

actions, 7-1

AI_TRANSDUCER block, 1-2, 3-3, C-1, D-1

AI_Transducer Parameters, E-13
alarm clear point, 6-1

alarm deadband, 6-1

alarm set point, 6-1

alarm setup, 6-1-6-2, E-8
ALARM_STATUS_FLAGS_1, C-2

ALARM_STATUS_FLAGS_2, C-2,C-3

ALARM_STATUS_FLAGS_3, C-3
ALARMI, C+4, C-5, C-6, C-7
ALARM2, C-4, C-5, C-6, C-7
alternate time constant, 4-4

analog input block, 1-2
ANALOG_INPUT block, 1-2, 3-3
AUTO. See automatic mode

automatic mode, 3-9

BAD_FLAGS_1, C-7,C-8
BAD_FLAGS_2, C-8
blocks, 1-2

mode types, 3-9

c

CAL_STD_RATIO_FROM_, C-8
CAL_X_TIME_CONST, C-8
CAL1_TEMP, C-8

CAL2_TEMP, C-8

calibration, 5-2-5-3, E-7
CARRIER_ATTEN_COEF, C-8
CARRIER_GRAVITY, C-8
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CARRIER_TEMP_COMP_, C-8
CARRIER_TEMP_EQ_COEFA, C-8
CARRIER_TEMP_EQ_COEFB, C-8
CARRIER_TEMP_EQ_COEFC, C-8
clear all alarms, 7-1, E-9
clear all holds, 7-1
commands, D-1-D-2
connections, 2-1-2-2
contact closure input, 1-3
contact closure output

specification, B-2
contact information, 9-2
COUNTDOWN_TIMER, C-8

current output setup, 8-1, E-10

D

DATA_REF_CNT_RATIO, C-8
DAYS_GAUGE_ON, C-9
DD. See device description
density setup, 4-2—4-3
density setup, E-2
Density Setup menu, 3-10
DENSITY_CAL_POINT1, C-9
DENSITY_HOLD_MODE, C-9
DENSITY_SLOPE, C-9
DETECT_SIG_VALUE, C-9
device description, 3-8
flow blocks, E-1-E-13
installation, 3-1
device ID, 3-4
device status, 8-3, E-12
Diag/Service menu, 3-10, E-9
DPRO_CMD, C-9
DRY_BULK_DENSITY_FOR_FLOW_MEAS, C-9

E

erase all entries, 7-1, E-9
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Index

F
fieldbus, 1-1, B-3

connector, 2-1

jumper settings, 2-2

parameters for DensityPRO, C-1-C-16

system connections, 2-1-2-2

troubleshooting, 9-1
FLOW_VOLUME_UNIT, C-10
FOUNDATION fieldbus

introduction, 1-1-1-3

system connections, 2-1-2-2

H

HEAD_TYPE, C-10
HV_CTL, C-10

I/O. See inputs, outputs.
inputs

contact closure, 1-3

overview, 1-3

specification, B-2
IOUT_HOLD_VALUE, C-10
IOUT_MAX_CORRECTION, C-10
IOUT_MIN_CORRECTION, C-10
IOUT1_VALUE, C-10
IOUT1_VALUE_PERCENT, C-10

J
jumper settings

for fieldbus board, 2-2

L
LAST_STD, C-10

link master, 1-2
loop test, 8-2, E-11
LUMP_STATUS, C-10

MAN. See manual mode

manual mode, 3-9
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MASS_FLOW_TIME_UNIT, C-10
MASS_FLOW_UNIT, C-10
MATERIAL_TYPE, C-10
MAX_IOUT_VALUE, C-10
MEA_NUM_AT_CURRENT_OUT_ALTMODE, C-11
MEA1_READ, C-11
MEA1_READOUT, C-11
MEA1_UNIT, C-12
MEA2_READ, C-12
MEA2_READOUT, C-12
MEA3_READ, C-12
MEA3_READOUT, C-12
MEA4_READ, C-13
MEA4_READOUT, C-13
MEASURE1_AT_MAX_IOUT, C-13
MEASURE1_AT_MIN_IOUT, C-13
MEASURE2_AT_MAX_IOUT, C-13
MEASURE2_AT_MIN_IOUT, C-13
MEASURE3_AT_MAX_IOUT, C-13
MEASURE3_AT_MIN_IOUT, C-13
MEASURE4_AT_MAX_IOUT, C-13
MEASURE4_AT_MIN_IOUT, C-13
menus, 3-10-3-11

Actions, 7-1

Alarms, 6-1-6-2

Density Setup, 3-10

Diag/Service, 3-10, 8-1-8-4

Gauge Calibration, 5-2-5-3

Setup, 4-1-4-6

Standardization, 5-1-5-2
methods. See menus.

MIN_IOUT_VALUE, C-13

NI-FBUS Configurator, 3-1-3-16
node address, 3-4
NUMBER_OF_RELAYS, C-13

0

OOS. See out of service mode
ordering information, A-1-A-2
other meas assign & modify, 4-6, E-5
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out of service mode, 3-9
outputs
4-20 mA current, 1-3, B-2
contact closure, B-2

overview, 1-3

P

parameters

alarm, C-1

alarm and status flags, C-1

bad flags, C-1

calibration, C-1

command, C-1

configuration, C-1

specific to DensityPRO, C-1-C-16

status, C-1
PD tag, 3-4
PIPE_INSIDE_DIAMETER, C-13
primary time constant, 4-4
PRIMARY_MEASURE_TYPE, C-14
PROCESS_TEMP_LEARNED_AT_CAL, C-14

REFERENCE_DENSITY, C-14
REFERENCE_TEMPERATURE, C-14
RELAY1_ALM_MODE, C-14
RELAY1_LATCH_MODE, C-14
RELAY2_ALM_MODE, C-14
RELAY2_LATCH_MODE, C-14
resource block, 1-2, 3-3

Root Menu, 3-10, E-1

S

safety

overview, ix
setup menu, 4-1-4-6
Setup menu, E-1
SIZE_UNIT, C-14
SOLID_ATTEN_COEF, C-15
SOLID_GRAVITY, C-15
SOLID_TEMP_COMP_POLY, C-15
SOLID_TEMP_EQ_COEFA, C-15
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Index

SOLID_TEMP_EQ_COEFB, C-15
SOLID_TEMP_EQ_COEFC, C-15
SOLUTION_POLY_COEFA, C-15
SOLUTION_POLY_COEEFB, C-15
SOLUTION_POLY_COEEFC, C-15
SOLUTION_POLY_COEFD, C-15
SOLUTION_POLY_TYPE, C-15
SOURCE_HALF_LIFE_VALUE, C-15
specifications, B-1-B-3
standardization, 5-1-5-2, E-6
STD_IN_USE_VALUE, C-15
STD_ON_PIPE_COND, C-15
STD_VALUE, C-15
STD_X_TIME_CONST, C-15
system restart, 7-1, E-8

T

TC_ALTERNATE, C-15

TC_PRIMARY, C-15

TEMP_CONSTANT, C-15
TEMP_INPUT_SOURCE, C-16
TEMP_OFFSET_CORRECTION, C-16
temperature compensation setup, 4-4—4-5, E-4
time constant setup, 4-4, E-3

transducer block, 1-2, 3-3

trim analog output, 8-2-8-3, E-12
troubleshooting

steps for fieldbus, 9-1

U

USE_TEMP_COMP_ON_STD, C-16

vV

view other meas, 4-6, E-6

VOLUME_FLOW_TIME_UNIT, C-16

W

wiring, 2-1-2-2
WKS_SINCE_LAST_STD, C-16
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X XRAY_MODE, C-16

XRAY_MAX_HOLD_TIME, C-16 XRAY_THRESHOLD, C-16

XRAY_MIN_HOLD_TIME, C-16
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